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Introduction

The STD template is a wizard to be used with Microsoft Word 97 for the preparation of ISO and ISO/IEC normative-type documents (International Standards, Technical Reports and International Standardized Profiles). It automatically creates the cover sheet of these documents, their foreword, headers and footers, and inserts a style sheet to facilitate the creation of the rest of the document.

The STD template replaces ISOSTD33, the ported version of ISOSTD30 to Word 97 which was distributed to a limited number of users for interim use before the release of the STD template. It allows the importation of files created using either ISOSTD30 or ISOSTD33.

Table 1 summarizes the various ISO templates available.
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 — ISO templates

Template name
Operating system
Word processor
Remarks

Automated templates (Wizard)

ISOSTD30
Windows 3.1

Windows 95
Word 6

Word 95
—

ISOSTD33
Windows 95

Windows NT4.0
Word 97
· Test version replaced by STD

STD
Windows 95

Windows 98

Windows NT4.0
Word 97
· Replaces ISOSTD33

Basic templates (no automated features)

BASICEN

BASICFR
Any operating system
Developed for Word 6 but works with any word processor 
· Saved as Word 6 format

· Replaced by BASICEN2 and BASICFR2

BASICEN2

BASICFR2
Any operating system
Any word processor a
· Available as both a Word template (extension .DOT) and in rich text format (extension .RTF) a 

· Replaces BASICEN and BASICFR

NOTE
The various ISO templates are designed to be upwards compatible.

a
If your word processor cannot open Word templates (extension .DOT), use the Word document (extension .RTF).

STD template for the preparation of normative-type documents, Version 1.0 — Reference manual
1 Scope

This reference manual provides standards writers with information for the preparation and formatting of ISO and ISO/IEC normative-type documents (International Standards, Technical Reports and International Standardized Profiles) using the STD template, version 1.0.

The STD template, version 1.0, has been developed for use with Microsoft Word 97, under Microsoft Windows 95 [OEM Service Release 2 (OSR2) recommended], Microsoft Windows 98 or Microsoft Windows NT 4.0 [Service Pack 3 (SP3) recommended]. It has not been tested with other versions of Word or other operating systems. It cannot function in non-VBA (Visual Basic for Applications) environments. The minimum hardware configuration is a PC-compatible computer equipped with at least a 133 MHz Pentium-type processor, at least 10 Mbyte of hard disk space free, a colour screen compliant with SVGA standard (minimum resolution: 800 x 600) and at least 16 Mbyte RAM (24 Mbyte or 32 Mbyte recommended). XE "Hardware configuration" 
NOTE 1
This reference manual was prepared using the STD template.

NOTE 2
Known problems with the template and their solutions are detailed in annex A.

2 Installation of the templates

 XE "Installation of the template" IMPORTANT — If you are using Windows on a network, do not perform the installation yourself; ask your network administrator.

The ISO templates are supplied as an automatic installation software.

To install the templates, download the template installation software or insert diskette No. 1 or the CD-ROM in the appropriate drive, then click on the “Start” button on the taskbar and select “Run”. Click on “Browse” and select the drive corresponding to the template support medium (floppy or CD-ROM reader) or the folder where the template installation software was downloaded. Select “ISOSTD.exe” if the template has been downloaded or “SETUP.EXE” in other cases and click on “Open”. In the “Run” dialogue box, click on the “OK” button.

Select the desired language for the setup instructions and click on the “OK” button.

Read the terms of use  XE "Terms of use for the STD template" and click on “Yes” or “No”; in the latter case, the installation will stop.

If you have accepted the terms of use, check that the path indicated in the dialogue box corresponds to that where you want to save the templates. If you want a different location than that proposed by the installation software, or if no location is specified, click on “Browse” and specify the location where you want to save the templates. Click on the “OK” button to start the installation; follow the instructions given on the screen.

Once the installation procedure has finished, the following user files will be saved at the specified location:

· BASICEN2.DOT: Basic template, English

· BASICFR2.DOT: Basic template, French

· BASICEN2.RTF: Basic (template) document, English

· BASICFR2.RTF: Basic (template) document, French

· STD.DOT: Wizard (automated template)

· README.TXT: Terms of use, English, or LISEZMOI.TXT Terms of use, French depending on the installation language chosen

NOTE
STD.DOT is not copied if the installation software does not detect the presence of Word 97.

The reference manual for use of the STD template (in the language corresponding to the installation language chosen) will be saved in the location specified for Word documents (to determine this location, open a Word document, select "Tools", "Options", and the tab "File Locations"):

· REFMSTDE.DOC: Reference manual for STD template, English

· REFMSTDF.DOC: Reference manual for STD template, French

3 Creating a new document based on the STD template

NOTE
In the following, the template is assumed to have been installed in the location proposed by the installation software.

 XE "Creating a new document based on the STD template" Start Word 97. In the menu bar select “File” and “New... ”.

In the “New” dialogue box, choose the “General” tab. Be sure that under the option “Create New” that “Document” is selected and not “Template”. Click once on the icon “Std.dot” then click on “OK”, or alternatively double click on “Std.dot”. See Figure 1.

A blank document will appear on the screen and the software will display the STD toolbar (see 4.1.1).
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1
 — Getting started on the template

4 Features of the template

4.1 User interface

4.1.1 STD toolbar

 XE "STD toolbar" Once the template is opened, a supplementary toolbar is displayed: this is the STD toolbar (see Figure 2) which can be used to perform most of the functions of the template.
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 — STD toolbar

The “Doc Info” button XE "Doc Info button"  opens the STD manager which is used to create a new document and to manage the administrative information entered (reference number, committees, titles, etc.). See 4.1.2.

The “Translate” button XE "Translate button"  creates a new document in either English or French based on the French or English original document respectively. However, only the basic elements of the document (cover sheet, foreword text, and titles of basic clauses) will be translated. See 4.6.

The “Import” button XE "Import button"  imports a document into the STD template. See 4.3.

The “Framework” button XE "Framework button"  inserts the framework elements (basic clauses, annexes, bibliography and other elements which may appear in normative-type documents). See 4.4.

The “Insert” button XE "Insert button"  displays or hides the “Insert” toolbar comprising buttons corresponding to some of the basic elements found in normative-type documents (clauses, notes, examples, etc. — see Figure 3).
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 — “Insert” toolbar

The “Export” button XE "Export button"  saves the document in a different Word format (Word 2 or Word 6/95). See 4.5.

The “Options” button XE "Options button"  allows the user to change the parameters of the user interface: use it for choosing the language of the dialogue boxes XE "Language:of the dialogue boxes" .

4.1.2 STD manager

The STD manager XE "STD manager"  is the most important part of the template software. You can access it via the “Doc Info” button on the STD toolbar. Using this software you can create or change a document and its associated administrative information. It contains three dialogue boxes “Parameters”, “Standardization system” and “Titles” (see Figure 4), described in detail in 4.7, 4.2.1 and 4.2.2 respectively.
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a) Parameters (see 4.7)
b) Standardization system (see 4.2.1)
c) Titles (see 4.2.2)
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 — “STD manager” dialogue boxes

4.1.3 Fields contained in the document

Part of the administrative information entered in the STD manager is inserted at the beginning of the document in “DEFINE” fields. It is imperative not to modify or delete these fields manually since this may provoke problems with the software associated with the STD manager.

4.1.4 Colour codes used in the document

4.1.4.1 General

Certain text or portions of text appear in a colour other than black. These colours have a meaning as indicated in 4.1.4.2 to 4.1.4.4. In order to ensure that the software works correctly it is absolutely necessary to follow the rules given in the following subclauses.

4.1.4.2 Blue text

 XE "Blue text" All elements which appear in blue in the document shall not be deleted or modified manually. If these data are incorrect or no longer valid, use the STD manager (see 4.1.2) to update or to correct them.

If you use a colour printer, program it to print your document in black and white. Do not modify the colours of the characters in your file.

4.1.4.3 Red text

 XE "Red text" For all the elements which appear in red, it is necessary to make an editorial choice, for instance

· indicating the number of the edition and changes in relation to a previous edition in the foreword, or

· when working in French, making a choice between the masculine or feminine gender, or

· completion of text or deletion of text which is not applicable.

4.1.4.4 Green text

 XE "Green text" Notes concerning editorial drafting rules (see 4.2.5) appear in green.

4.2 Creating documents

4.2.1 Standardization system

 XE "Creating documents" 

 XE "Standardization system" To create a new document, open the template (see clause 3), click on the “Doc Info” button of the STD toolbar, then go from the first dialogue box (see its use in 4.7) to the second by clicking the “Next” button. The second dialogue box displays the Standardization system.

Enter data into the fields as explained in Figure 5. All the data in these fields can be modified after closure of the STD manager (see 4.2.4) except two:

· the “Doc. language” field;

· the “Include notes on drafting” field.

Ensure, therefore, that the content of these fields is correct, and then click on the “Next” button to proceed to the next dialogue box where you enter the titles of the document. XE "Document language cannot be modified" 

 XE "Language:of document cannot be modified" 
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1
 XE "Administrative information:entering" Number and title of the technical committee (TC) responsible for the work, and the organization providing the secretariat

2
Number and title of the subcommittee (SC) responsible for the work, if applicable

3
Number of the working group (WG) responsible for the work, if applicable

4
Serial number of the working document [general number attributed by the TC or SC secretariat (see the ISO/IEC Directives, Part 1, 1995[1], K.1.1.1)]

5
Check box to insert editorial notes on drafting (extracts from the ISO/IEC Directives, Part 3, 1997) when creating a new document

6
Document number (for instance 9000 for the standard ISO 9000)

7
Part number, if necessary (for instance 6 for the standard ISO 2382-6)

8
Day, month and year of the current project (by default, the current day)

9
Number of the project (for the second and subsequent projects, the project number will appear at the end of the document reference number, for instance “ISO/CD 965-1.2” is the second project of the document “ISO/CD 965-1”)

10
Name of the organization (ISO or ISO/IEC), type of document (International Standard, International Standardized Profile or Technical Report), stage (20 to 60) and document sub-type (Amendment or Technical Corrigendum)

11
If the Amendment or Technical Corrigendum is selected as a document sub-type (see item 10), indicate the Amendment or Technical Corrigendum number and the year of publication of the amended or corrected document

12
Language of the document XE "Language:of the document" 

 XE "Standardization system dialogue box" : F for French, E for English

NOTE
After clicking on “End” in the “Titles” dialogue box it is no longer possible to modify the document language.
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 —“Standardization system” dialogue box

4.2.2 Titles

 XE "Document titles" 

 XE "Titles" 

 XE "Amendment title" 

 XE "Technical Corrigendum title" Enter, as indicated in Figure 6, the three elements of the title into the corresponding fields in each of the languages. See the editorial rules for titles in 5.3.2.1.

Use the “Special charac” button to insert symbols — see Figure 6.

NOTE 1
It is not possible to use italics or underlined characters in the elements of the title.

NOTE 2
Certain special characters which cannot be entered using the keyboard or via the “Special characters” tab in the “Insert” menu can meanwhile be entered using their ASCII codes (e.g. Alt 0160 for a nonbreaking space).

NOTE 3
It is not possible to enter the title of an Amendment or a Technical Corrigendum. (See A.1.11.)

WARNING — Do not use quotation marks (“ and ” or « and ») in the elements of the title since the text following the first quotation mark will not appear in the document and the title of the other elements will be modified. Use two apostrophes (‘) instead of quotation marks. 
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1
Introductory element (optional)

2
Main element (obligatory)

3
Complementary element (optional) or part title (obligatory) in the case of a standard in parts

NOTE

For standards in parts, enter the title of the part in the third field; omit the word “Part” and the part number, since the template will insert them for you.

4
The “Special charac” button can be used to insert symbols in the title. Click on this button to display a panel of symbols from which you can select a character. Note that only the font “(normal text)” can be used. XE "Titles dialogue box" 
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 — “Titles” dialogue box 

4.2.3 Replaced documents

 XE "Replaced documents" By selecting the “Replaced documents” tab in the “Titles” dialogue box, you can enter and modify the list of replaced documents as necessary.

The entries in this dialogue box will be used to complete the foreword text created by the template.

To enter a replaced document, select the document type in the list on the left or type it in the field above the list, then enter the document reference number (for instance 2382-6 for the standard ISO 2382‑6) in the second field, and the year of publication in the following field; click on the “Add” button. See Figure 7.

To delete a document from the list on the right, select it, then click on the “Delete” button.
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1 Document type

2 Document reference number (for instance 2382-6 for the standard ISO 2382‑6)

3 Year of publication of the replaced document

4 List of document types XE "Replaced documents dialogue box" 
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 — Data entry for the “Replaced documents” dialogue box

4.2.4 Confirmation of data entry

After having entered the data in 4.2.1 to 4.2.3, click on the “End” button XE "End button"  to execute the program that creates and updates the cover sheet, the headers and footers, and the foreword of the document. 

WARNING — All information can be modified afterwards with the exception of the document language (see 4.2.1) and the insertion of notes concerning editorial drafting rules (see 4.2.5).

4.2.5 Notes concerning editorial drafting rules

 XE "Notes concerning editorial drafting rules" Notes concerning editorial drafting rules XE "Editorial drafting rules:notes concerning"  in accordance with the ISO/IEC Directives, Part 3[2] can be inserted in the document (see item 5 in Figure 5). It is only possible to insert these notes when creating a new document. These notes appear in green and should be deleted upon completion of your document.

A document framework or skeleton (black and red text) is inserted together with the editorial notes; it can be used as the basis for preparing the document.

4.3 Importing files created using a different template

4.3.1 General

 XE "Importing files:created using a different template" 

 XE "Importing files" It is possible to import files created using a different word processor template into the STD template as long as the file has been saved in Word 97 format. To import a file that is in another format (Word 6.0/95 or other word processor), it is necessary first to open the file in Word 97 and then to save it in Word 97 format.

To import a file, first create a new document using the STD template (see 4.2). Then click on the “Import” button in the STD toolbar. Select the file to be imported from the “Open” dialogue box then click on the “Open” button. 

The STD manager opens and it is necessary to enter the following information:

a) name of the organization;

b) document type;

c) document number;

d) part number, if applicable;

e) document sub-type, followed by the number of the Amendment or Technical Corrigendum;

f) document language.

The program then applies the stylesheet of the STD template. The dialogue boxes of the STD manager open again and you may then to enter the remaining data for the document. (Altogether the STD manager dialogue boxes open twice for data entry.)

Table 2 gives a summary of the different means of importing files, previously saved in different formats or created using another template, into the STD template. XE "Importing files:created using ISOSTD30" 

 XE "Importing files:created using ISOSTD33" 
4.3.2 Special cases: ISOSTD30 and ISOSTD33 templates

Contrary to the general case given in 4.3.1, files created using the ISOSTD30 and ISOSTD33 templates, regardless of their format (Word 6.0, 95 or 97), will always be recognized and the corresponding fields to those in the STD template will be recovered. Problems related to importing files from the ISOSTD30 and ISOSTD33 templates are indicated in A.3.

4.3.3 Special cases of files created using the STD template, where the standardization system is not available

 XE "Importing files:created using the STD template, where the standardization system is not available" If on opening a file, all the fields in the “Standardization system” dialogue box are dimmed, it is necessary to create a new document based on the STD template and then to enter the relevant administrative data in the STD manager. Next, in the source document, cut all the text following the scope and paste it into a suitable place in the newly created template document. Follow the same procedure for the foreword and introduction as necessary. 
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 — Importing files created using a different template

Format
Template
Instructions

Word 2
BASICEN and BASICFR or other
Save the source file in Word 97 format. Create a new document based on the STD template, click on “Import”; find the file to be imported, select it and then click on the “Open” button. (See 4.3.1.)

Word 6,Word 95
ISOSTD30
Create a new document based on the STD template, click on “Import”; find the file to be imported, select it and then click on the “Open” button. (See 4.3.2.)


BASICEN and BASICFR or other
Save the source file in Word 97 format. Create a new document based on the STD template, click on “Import”; find the file to be imported, select it and then click on the “Open” button. (See 4.3.1.)

Word 97
ISOSTD33, BASICEN and BASICFR or other
Create a new document based on the STD template, click on “Import”; find the file to be imported, select it and then click on the “Open” button. (See 4.3.2 and 4.3.3 for files created using the STD template but where the Standardization system is not available.)

Other than Word
BASICEN and BASICFR or other
Save the source file in Word 97 format. Create a new document based on the STD template, click on “Import”; find the file to be imported, select it and then click on the “Open” button. (See 4.3.1.)

4.4 Insertion of framework elements

 XE "Insertion of framework elements" 

xe “Framework“Framework elements can be easily inserted using the STD template (basic clauses, annexes, bibliography, and other elements that may appear in normative-type documents) by clicking on the “Framework” button of the STD toolbar. These elements may include boilerplate texts. When these elements correspond to a clause, they will be inserted in the “Heading 1” style.

To insert one or more framework elements, place the cursor at the place of intended insertion in a “Normal” style paragraph. Click on the “Framework” button. In the “Framework” dialogue box (see Figure 8), select the first of the elements to be added into the document from the list on the left-hand side and then click on the “Add” button to add it in the right-hand list; if necessary, enter data into the supplementary dialogue box. Proceed in the same manner for the other elements, in the order which they should appear in the document.

To delete an element from the right-hand list, select it then click on the “Delete” button.

NOTE 1
The “Framework XE "Framework elements:deletion of" ” dialogue box does not show the framework already present in the document and any previously inserted framework elements cannot be deleted using it: the list on the right-hand side is empty each time this dialogue box is opened.

NOTE 2
The titles of elements appear in the document language XE "Language:of element titles"  previously specified.
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 XE "Framework dialogue box" 
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 — “Framework” dialogue box

4.5 Saving files

4.5.1 Principle

 XE "Saving files" Once all the administrative information has been entered for a new document and the “End” button has been clicked, the template saves the file under a name which is generated automatically by the template from the administrative data entered in the STD manager. It is impossible to change the name of this file or to cancel it from being saved at this time; it is possible, however, to designate the location where the file will be saved; this location will become the default storage location for future sessions. 

The name of the file is generated from the following information:

g) name of the organization;

h) indication of the type of document;

i) document reference number, including the part number;

j) letter, if applicable, representing the document sub-type, followed by the number of the Amendment or Technical Corrigendum;

k) letter representing the document language, in parentheses.

Once saved, a document can be renamed. The file will retain this name unless you alter some of the administrative information associated with the file via the STD manager. See 4.7 for details concerning the behaviour of the template if you rerun the STD manager of a renamed file. XE "Renaming a file" 

 XE "Renaming a file:problems associated with" 
Known problems linked with saving files are given in A.2.

4.5.2 Exchange formats 

For exchange purposes, it is possible to save a file in a different Word format, as well as with a short file name. For this purpose, use the “Export” button.

To export correctly files in Word 6.0/95 format, it is necessary that the binary conversion filter to Word 6.0/95 format [converter delivered with Office 97 Service release 1 (SR-1), available from Microsoft Corporation] is installed; otherwise the files will be saved in RTF format. XE "Saving files:in a different format" 

 XE "Saving files:in Word 6.0/95 format" 
4.5.3 Use of existing files created using the STD template for preparing a new document

 XE "Creating documents:from pre-existing files created using the STD template" A file already based on the STD template can be used to create another document without having to “import” the file. To do this, open the file, select “Save as” and enter a different file name. Click on the “Doc Info” button then on the “binoculars” button adjacent to the name displayed in red. You can then enter the data for the new document by clicking the “Next” button without risk of deleting the original file. After clicking on the “End” button in the “Titles” dialogue box, the STD manager will attribute a file name in accordance with the administrative information entered (see 4.5.1).

This procedure has no effect on the original file; it is neither renamed nor relocated.

To prepare the framework of the second language of the document, use the “Translate” button (see 4.6).

4.6 Translating a document for which a file based on the STD template already exists into English or French

 XE "Translating:a document" 

 XE "Translating:basic elements" The STD template can translate the basic elements which were entered using the “Framework” dialogue box of an existing STD template file into English or French.

If the file of the document that you wish to translate has not been saved since it was last modified, save it. If the file of the document that you wish to translate is currently closed, open it. Click on the “Translate” button. In the “Translate to” dialogue box click on English or French as appropriate and then click on “OK”. The first dialogue box of the STD manager will open. Use the “Next” button to check the information in the various dialogue boxes; modify the data if necessary. Click on the “End” button to execute the program and to create a new document from the existing one.

The new document will contain the cover sheet, the headers and footers and the foreword corresponding to the administrative information input from the STD manager; the remaining text will not be translated from the original language with the exception of the titles of the basic elements and any associated automatically generated boilerplate texts which will be added in the new language. The boilerplate texts of the translated document will remain and will need to be deleted.

NOTE
This is not a computer-aided translation (CAT) programme.

4.7 Links between language versions

 XE "Links between:language versions" 

 XE "Links between:files" The STD template allows linking between different linguistic versions of the same document. This is managed in the first dialogue box (“Parameters”) of the STD manager.xe “Managing versions“
Click on the “Doc Info” button. The “Parameters” dialogue box gives the name and location of any files linked to the current file (see Figure 9).
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 — “Parameters” dialogue box

 XE "Red file name" 

 XE "File name appearing in red" A file name may appear in red in two cases:

· the name of the file has changed since it was linked (see the information used to generate automatically the name in 4.5.1);

· the file in question has been moved from one location to another since it was linked.

In both cases, clicking on the “binoculars” button XE "Binoculars button"  adjacent to the name in red creates a link with the specified file and displays the “Open” dialogue box. Select the file and click on the “Open” button. The file name and location of the file selected will now appear in the field.

If the file of the different linguistic version is not indicated although it exists, it is probably because it was not created using the “Translate” button. To link the other linguistic version, click on the “binoculars” button adjacent to the empty field, browse to locate the file, select the file and click on the “Open” button. The file name and location of the file selected will now appear in the field.

To synchronize the document titles in each of the two files, open the version most up to date, re-establish the links with other files if necessary (files displayed in red or absent from the “Parameters” dialogue box) and click on the “Synchronize” button XE "Synchronize button" . XE "Document titles:synchronizing" 
Consequently, the document titles in the unopened language document will be replaced in the “Parameters” dialogue box with those which have just been defined in the open document.

ATTENTION — Make sure that the synchronization is carried out from the most recent version !

The problems concerned with linking files are explained in A.2.

5 Use of the stylesheet

5.1 General

The stylesheet is in the form of a document skeleton which contains the informative preliminary elements found in standards (cover sheet, table of contents, foreword and introduction) as well as the first normative page containing the scope.

NOTE 1
If editorial notes on drafting are inserted (see 4.2.5), the document will also contain examples of basic elements.

Starting from the scope, new elements may be inserted

· by using the buttons in the “Insert” toolbar for basic elements (clauses, subclauses, notes, examples, etc.), or

· by using the “Framework” button for basic elements (clauses, annexes, bibliography, etc.), and

· by selecting the corresponding style from the Style drop-down list in the formatting toolbar for other elements.

IMPORTANT — The “Insert” and “Framework” buttons have certain automated functionalities associated with them (e.g. automatic inserts are programmed for certain styles). Although the complete set of available template styles is also accessible via the Style drop-down list in the formatting toolbar and the “Style” command of the “Format” menu, unless otherwise specified do not use these for applying styles since the automated features will be missing; use the “Insert” and “Framework” buttons XE "Framework button"  XE "Insert button" 

 XE "Insert button:automation associated with" 

 XE "Framework button:automation associated with" .

A summary of the template styles, including instructions for their use and their means of application, is given for information in annex B. A quick reference guide indicating which style corresponds to which element is given in annex C.

NOTE 2
A certain number of the STD template styles are based on predefined Microsoft styles. These styles are recognized by the various linguistic versions of Word and their names will be translated automatically into the language of the Word version which you are using. For these Microsoft styles, the user will need to derive the correspondence between the name displayed and that given in this manual; for example, if the same document is opened using English and French versions of Word, text styled “Footnote Reference” in the English version is called “Appel de note” in the French version (see also annexes B and C, table footnote a). The names of the other template style are in English.

Each element is represented by a distinct style; each style has a predefined format associated with it. For example, a term in the “Terms and definitions” clause is in boldface, and the corresponding definition is in lightface. Never alter the predefined format associated with a style using the “Format” “Style” command. If you need to emphasize a piece of text, use only the formatting buttons of your word processor; for example, bold, italic or underlining. Furthermore, do not use special fonts to emphasize a piece of text.

Note that in order for a conversion process to be successful it is essential that the styles are applied consistently in accordance with the rules given in this clause. When one element is “nested” in another, apply the predominant style and format the “nested” element using the formatting commands of your word processor (do not use the “Format” “Style” command). Examples of “nested” elements include notes in lists, together with lists in notes, lists in footnotes to the text, and lists in table and figure footnotes. XE "Nested elements" 
Note that if you create your own styles, their conversion cannot be assured; they may be mapped to the ‘‘Special” style (see 5.3.16) in certain conversion procedures.

The page layout and presentation should be as simple as possible. It is preferable to use a single-column page layout than to insert manual page or section breaks. However, when for layout purposes it is necessary to create a new section, beware that the automatic page numbering will be restarted at 1 for each section unless specified otherwise. To avoid this, from the “View” menu, choose “Header and Footer”. In the “Header and Footer” toolbar, click on the “Page Setup” button and deselect the check box “Different first page” in the “Layout” tab and click on “OK”. Close the “Header and Footer” toolbar. Choose “Page Numbers...” from the “Insert” menu. Click on “Format…” and select the option “Continue from previous section”. Click twice on the “OK” button. XE "Sections:creating new" 

 XE "Creating a new section" 
WARNING — Do not remove the section breaks already present in the document skeleton otherwise the headers and footers will not be correct.  

If the section break between sections 2 and 3 falls on an odd-numbered page, the page which follows will be blank since the first page of section 3 has been specified to be an odd-numbered page (i.e. page 1) in the STD template.

The different styles available in the STD template are described in 5.2 to 5.4.

As far as practicable, the typography and content of the stylesheet are in conformity with the rules given in the ISO/IEC Directives, Part 3. However, for the purpose of submitting electronic files, the formatting conventions of the stylesheet supersede those given in the ISO/IEC Directives, Part 3. In the event of any contradiction in requirements, or in the case of enquiries, please contact the editorial department at the ISO Central Secretariat.

5.2 Insertion of subdivisions

5.2.1 Clauses

5.2.1.1  SEQ H4L2SCL2 \h \r1 Drafting rules

 XE "Clauses" A clause is the basic component in the subdivision of the content of a standard.

The clauses in each standard or part shall be numbered with arabic numerals, beginning with 1 for the “Scope” clause. The numbering shall be continuous up to but excluding any annexes.

Each clause shall have a title, placed immediately after its number, on a line separate from the text that follows it.

5.2.1.2  SEQ H4L2SCL2 \h \r1 Styles

Names:
Heading 1 XE "Styles:Heading 1" 

 XE "Styles:a2" 

 XE "Heading 1"  (in the body of the document) 


a2 XE "a2 "  (in the annexes)

NOTE
See also Table 3.

Automatic numbering: yes

5.2.1.3 Applying the style

Click on the “Clause/Subclause with title” button XE "Clause/Subclause with title button"  in the “Insert” toolbarxe “Insert button“; select the tab (“Body” or “Annex”) corresponding to the intended position of the clause, then click on <1> or <A.1> accordingly.

Alternatively, use the keyboard shortcut:

· body of the document: Ctrl+Shift+1 or the corresponding keyboard shortcut for Heading 1 which you can find using your software on-line help;

· annex: Ctrl+2.

5.2.1.4 Remarks

The clause number shall have the same typographic format as the clause title. If it does not, select the paragraph mark at the end of the clause title, and then apply to it the correct format using the tools of the formatting toolbar or reapply the corresponding style.

Hitting return after you have entered a clause will put the cursor in a new paragraph in the style ‘‘Normal” (see 5.2.3).

The “Increase Indent” and “Decrease Indent” buttons on the toolbar apply a higher or a lower level of heading respectively.

Certain clauses, which follow specific editorial rules, can be inserted using the “Framework” button (see 5.3.6).

5.2.2 Subclauses

5.2.2.1 Drafting rules

 XE "Subclauses" A subclause is a numbered subdivision of a clause. A primary subclause (e.g. 6.1, 6.2, etc.) may be subdivided into secondary subclauses (e.g. 6.1.1, 6.1.2, etc.), and this process of subdivision may be continued as far as the fifth level (e.g. 6.1.1.1.1.1, 6.1.1.1.1.2, etc.).
Subclauses shall be numbered with arabic numerals. Numbers given to the subclauses of an annex shall be preceded by the letter designating that annex followed by a full-stop.

A subclause shall not be created unless there is at least one further subclause at the same level. For example, a piece of text in clause 10 shall not be designated subclause “10.1” unless there is also a subclause “10.2”.
Each primary subclause should preferably be given a title, which shall be placed immediately after its number, on a line separate from the text that follows it. Secondary subclauses may be treated in the same way. Within a clause or subclause, the use of titles shall be uniform for subclauses at the same level, e.g. if 10.1 has a title, 10.2 shall also have a title. In the absence of titles, key terms or phrases (composed in distinctive type) appearing at the beginning of the text of the subclause may be used to call attention to the subject matter dealt with. Such terms or phrases will not be listed in the table of contents.

5.2.2.2 Subclauses with titles

5.2.2.2.1 Styles

xe “Subclauses:with titles“Names:
Heading 2 XE "Heading 2" 

 XE "Heading 3" 

 XE "Heading 4" 

 XE "Heading 5" 

 XE "Heading 6" 

 XE "Styles:Heading 6" 

 XE "Styles:Heading 5" 

 XE "Styles:Heading 4" 

 XE "Styles:Heading 3" 

 XE "Styles:Heading 2"  to Heading 6 (in the body of the document)


a3 to a6  XE "Styles:a3" 

 XE "Styles:a4" 

 XE "Styles:a5" 

 XE "Styles:a6" 

 XE "a3 " 

 XE "a4 " 

 XE "a5 " 

 XE "a6 "  (in the annexes) 

NOTE
See also Table 3.

Automatic numbering: yes

5.2.2.2.2 Applying the style

Click on the “Clause/Subclause with title” button XE "Clause/Subclause with title button"  in the “Insert” toolbarxe “Insert toolbar“; select the tab (“Body” or “Annex”) corresponding to the intended position of the subclause with title, then click on the button corresponding to the desired subdivision level (the label on the buttons gives an example of the numbering).

Alternatively, use the keyboard shortcut:

· body of the document: Ctrl+Shift+ the number corresponding to the desired level or the corresponding keyboard shortcut for the heading level which you can find using your software on-line help;

· annex: Ctrl+ the number corresponding to the desired level plus 2 (e.g. to create A.1.1 in clause A.1, press Ctrl+3).

5.2.2.2.3 Remarks

The subclause number shall have the same typographic format as the subclause title. If it does not, select the paragraph mark at the end of the subclause title, and then apply to it the correct format using the tools of the formatting toolbar or reapply the corresponding style.

Do not use these styles when only key terms or phrases at the beginning of a subclause need to be emphasized as is often the case for lists of apparatus XE "Apparatus" 

 XE "Emphasizing text" 

 XE "Reagents"  and of reagents; use instead the style “Subclause without title” (see 5.2.2.3).

Hitting return after you have entered a subclause with a title will put the cursor in a new paragraph in the style ‘‘Normal” (see 5.2.3).

The “Increase Indent” and “Decrease Indent” buttons on the toolbar apply a higher or a lower level of subdivision respectively.

Although the stylesheet terminology concerning subclauses conforms with that used in the ISO/IEC Directives, Part 3, 1997, 5.2.3 and 5.2.6, the style names have been attributed to facilitate their autonumbering rather than to reflect this terminology. Table 3 shows the style names and examples of the numbering produced both in the body of the standard and in the annexes.

Table 0\IF >= 1 "D." 

SEQ table 
3
 — Clauses and subclauses: their style names and examples of numbering

Terminology in ISO/IEC Directives, Part 3
Body of standard
Annexes


Style name
Example of numbering 
(in this case 
for clause 4)
Style name
Example of numbering 
(in this case 
for clause A.2)

Clause

Heading 1
4
a2
A.2

Subclause with title
level 1
Heading 2
4.1
a3
A.2.1


level 2
Heading 3
4.1.1
a4
A.2.1.1


level 3
Heading 4
4.1.1.1
a5
A.2.1.1.1


level 4
Heading 5
4.1.1.1.1
a6
A.2.1.1.1.1


level 5
Heading 6
4.1.1.1.1.1
—a
—a

Subclause without title
level 1
p2
4.1
p3
A.2.1


level 2
p3
4.1.1
p4
A.2.1.1


level 3
p4
4.1.1.1
p5
A.2.1.1.1


level 4
p5
4.1.1.1.1
p6
A.2.1.1.1.1


level 5
p6
4.1.1.1.1.1
—a
—a

a
The stylesheet is limited to four levels of subdivision of subclauses in annexes although the ISO/IEC Directives, Part 3, allows a fifth level.

5.2.2.3 Subclauses without titles

5.2.2.3.1 Styles

 XE "Subclauses:without titles" Names: p2 XE "p2" 

 XE "p3" 

 XE "p4" 

 XE "p5" 

 XE "p6" 

 XE "Styles:p2" 

 XE "Styles:p3" 

 XE "Styles:p4" 

 XE "Styles:p5" 

 XE "Styles:p6"  to p6

Automatic numbering: no

5.2.2.3.2 Applying the style

Click on the ‘‘Subclause without title” button in the “Insert” toolbar; type the number of the subclause and click “OK”.

5.2.2.3.3 Remarks

If text styled “p2” to “p6” is subsequently restyled, the number and the tabulation will remain and will need to be deleted manually. 

Hitting return after you have entered a subclause without a title will put the cursor in a new paragraph in the style ‘‘Normal”.

Although the stylesheet terminology concerning subclauses conforms with that used in the ISO/IEC Directives, Part 3, 1997, 5.2.3 and 5.2.6, the style names have been attributed to facilitate their autonumbering rather than to reflect this terminology. Table 3 shows the style names and examples of the numbering produced both in the body of the standard and in the annexes.

5.2.3 Paragraphs

5.2.3.1  SEQ H4L2SCL2 \h \r1 Drafting rules

 XE "Paragraphs" A paragraph is an unnumbered subdivision of a clause or subclause.

5.2.3.2  SEQ H4L2SCL2 \h \r1 Style

Style name: Normal XE "Normal" 

 XE "Styles:Normal" 
Automatic numbering: no

5.2.3.3 Applying the style

Select “Normal” XE "Normal keyboard shortcut"  from the Style drop-down list or use the keyboard shortcut Ctrl+Shift+N.

5.2.3.4 Remarks

All the styles in the stylesheet have been based on the “Normal” style.

IMPORTANT — Most of the elements that can be inserted using the “Framework” button require that the cursor be positioned in a “Normal” style paragraph. Therefore it is useful to memorize the keyboard shortcut command given in 5.2.3.3.

5.2.4 Lists

5.2.4.1 Drafting rules

 XE "Lists" Lists may be introduced by a sentence, a complete grammatical proposition followed by a colon, or by the first part of a proposition (without a colon), completed by the items in the list.

Each item in a list shall be preceded by a dash (i.e. an unordered list) (note that although the ISO/IEC Directives, Part 3, also allows list items to be preceded by a bullet only the dash option has been implemented in the stylesheet) or, if necessary for identification, by a lower-case letter followed by a parenthesis (i.e. an ordered list). If it is necessary to subdivide further an item in the latter type of list, arabic numerals followed by a parenthesis shall be used.  XE "Emphasizing text" 
Key terms or phrases may be composed in distinctive type to call attention to the subject matter dealt with in the various list items. Such terms or phrases will not be listed in the table of contents; if it is a requirement that they are listed, they shall not be presented as list items but as subclause titles.

5.2.4.2 Unordered lists

5.2.4.2.1 Styles

xe “Unordered lists“Names:
List Continue to List Continue 4 XE "List Continue" 

 XE "List Continue 2" 

 XE "List Continue 3" 

 XE "List Continue 4" 

 XE "Styles:List Continue 4" 

 XE "Styles:List Continue 3" 

 XE "Styles:List Continue 2" 

 XE "Styles:List Continue" 
Automatic numbering: yes

5.2.4.2.2 Applying the style

 XE "List item identifiers:unordered list" Click on the “Lists” button on the “Insert” toolbar; select the “Unordered” tab and click on the list item level desired.

5.2.4.2.3 Remarks

For unordered lists, the text of each list item is, by default, automatically preceded by a dash. Each level is inset with respect to the previous one.

After having typed the text in the unordered list item, press return to put the cursor in the next list item at the same level.

The “Increase Indent” and “Decrease Indent” buttons on the toolbar apply a higher or a lower level of subdivision respectively.

If a list item contains more than one paragraph, only the first paragraph should be preceded by a dash. To effect this, create the complete series of list items, each preceded by a dash. Then, one by one (since by default, only the dash of the first paragraph of a selection will be eliminated) select the list items which are not to be preceded by a dash and click first on the “Lists” button of the “Insert” toolbar, then on the “Skip numbering” button. If it is necessary to reinsert a dash, select the paragraph concerned and proceed as indicated in 5.2.4.2.2.

5.2.4.3 Ordered lists

5.2.4.3.1 Style

 XE "Ordered lists" Names:
List Number to List Number 4 XE "List Number" 

 XE "List Number 2" 

 XE "List Number 3" 

 XE "List Number 4" 

 XE "Styles:List Number 4" 

 XE "Styles:List Number 3" 

 XE "Styles:List Number 2" 

 XE "Styles:List Number" 
Automatic numbering: yes

5.2.4.3.2 Applying the style

Click on the “Lists” button on the “Insert” toolbar; select the “Ordered” tab and click on the appropriate list item level.

5.2.4.3.3 Remarks

In an ordered list, the list item identifiers  XE "List item identifiers:ordered list" are generated automatically in the following sequence:

level 1: a), b), c), etc.

level 2: 1), 2), 3), etc.

level 3: i), ii), iii), etc.

level 4: I), II), III), etc.

with each level being inset with respect to the previous one.

After having typed the text in the ordered list item, press return to put the cursor in the next list item at the same level.

The “Increase Indent” and “Decrease Indent” buttons on the toolbar apply a higher or a lower level of subdivision respectively.

By default, the numbering at level 1 is continuous from the beginning to the end of the document. To restart the numbering, click the check box “Restart numbering” before clicking on the button corresponding to the desired level of the “Lists” dialogue box.

If a list item contains more than one paragraph, only the first paragraph should have an identifier (i.e. a letter or number followed by a parenthesis). To effect this, create the complete series of ordered list items. Then, one by one (since by default, only the list item identifier of the first paragraph of a selection will be eliminated) select the list items which are not to be preceded by an identifier and click first on the “Lists” button of the “Insert” toolbar, then on the “Skip numbering” button. If it is necessary to restart the numbering, select the paragraph concerned and proceed as indicated in 5.2.4.3.2.

If the list item identifier (i.e. the letter or number followed by a parenthesis) does not have the correct typographic format (i.e. 10 pt, upright, lightface), select the paragraph mark at the end of list item text and apply the correct format using the formatting buttons, or reapply the appropriate style to it.

5.2.5 Annexes

5.2.5.1  SEQ H4L2SCL2 \h \r1 Drafting rules

 XE "Annexes" Annexes shall appear in the order in which they are cited in the text. Each annex shall be designated by a heading comprising the word “Annex” followed by a capital letter designating its serial order, beginning with “A”, e.g. “Annex A”. The annex heading shall be followed by the indication “(normative)” or “(informative)”, and by the title, each on a separate line. Numbers given to the clauses, subclauses, tables, figures and mathematical formulae of an annex shall be preceded by the letter designating that annex followed by a full-stop. The numbering shall start afresh with each annex. A single annex shall be designated “Annex A”.

Normative annexes are integral parts of the standard. Their presence is optional. An annex’s normative status (as opposed to informative) shall be made clear by the way in which it is referred to in the text, by a statement to this effect in the foreword and by an indication in the table of contents and under the heading of the annex.

Informative annexes give additional information intended to assist the understanding or use of the standard and shall not contain provisions to which it is necessary to conform in order to be able to claim compliance with the standard. Their presence is optional. An annex’s informative status (as opposed to normative) shall be made clear by the way in which it is referred to in the text, by a statement to this effect in the foreword and by an indication in the table of contents and under the heading of the annex.

5.2.5.2 Style

Name: ANNEX XE "ANNEX" 

 XE "Styles:ANNEX" 
Automatic numbering: yes

5.2.5.3 Applying the style

Use the “Framework” buttonxe “Framework button“ (see 4.4).

5.2.5.4 Remarks

Position the cursor in an empty “Normal” style paragraph in the location where you want to introduce the annex, click on the “Framework” button, select the type of annex (normative or informative) that you want to insert then click on the “Add” button; type the title in the “Informative [Normative] annex / Title” dialogue box and click on the “OK” button. It is possible to insert several annexes before closing the “Framework” dialogue box.

This style applies only to the heading, status and title of an annex. Clauses in annexes are styled “a2” (see 5.2.1) and subclauses with titles in annexes are styled “a3” to “a6” (see 5.2.2.2); other elements are styled in the same way as in the body of a standard.

5.3 Inserting elements

5.3.1 Cover sheet

5.3.1.1  SEQ H4L2SCL2 \h \r1 General

 XE "Cover sheet" The cover sheet gives the set of information applicable to the document (reference to the working document, organization responsible for the secretariat, reference to the responsible TC, SC and/or WG, reference and title of the document, indication of the document type and sub-type, if applicable, the stage and document language, the name of the file and a reference to the template used).

The title pages of enquiry drafts, final drafts and final publications are prepared in a standard format by the Central Secretariat of ISO.

5.3.1.2  SEQ H4L2SCL2 \h \r1 Style

Name: zzCover XE "zzCover" 

 XE "Styles:zzCover" 
Automatic numbering: no

5.3.1.3 Applying the style

Element inserted by the template.

5.3.1.4 Remarks

The entire cover sheet is in the “zzCover” style.

The cover sheet is generated from the data entered in the STD manager. Therefore, changes to the cover sheet shall be made only by changing the data in the STD manager; click on the “Doc Info” button (see 4.2) and add or change the data in the relevant dialogue box.

Do not delete the name of the file and the reference to the template at the bottom of the cover sheet.

5.3.2 Document title

5.3.2.1  SEQ H4L2SCL2 \h \r1 Drafting rules

 XE "Document title" The wording of the title shall be established with the greatest care; while being as concise as possible, it shall indicate, without ambiguity, the subject matter of the standard in such a way as to distinguish it from that of other standards, without going into unnecessary detail. Any necessary additional particulars shall be given in the scope.

The title shall be composed of separate elements, each as short as possible, proceeding from the general to the particular. In general, not more than the following three elements shall be used:

a)
an introductory element (optional) indicating the general field to which the standard belongs (this can often be based on the title of the committee which has prepared the standard);

b)
a main element (obligatory) indicating the principal subject treated within that general field;

c)
a complementary element (optional) indicating the particular aspect of the prin​cipal subject or giving details that distinguish the standard from other standards, or other parts of the same standard.

The complementary element is necessary if the standard covers only one or a few aspects of the subject indicated in the main element.

In the case of a standard published as a series of parts, the complementary element serves to distinguish and identify the parts [the introductory element (if present) and the main element remaining the same for each part].

EXAMPLE

ISO 3098‑1
Technical product documentation 
—
Lettering
—
Part 1: Latin alphabet, numerals and marks

ISO 3098‑2
Technical product documentation
—
Lettering
—
Part 2: Greek alphabet

If the standard covers several (but not all) aspects of the subject indicated in the main element, the aspects covered shall be referred to by a general term such as “specification” or “mechanical requirements and test methods” rather than be enumerated one by one.

The complementary element shall be omitted if the standard both

—
covers all essential aspects of the subject indicated in the main element, and

—
is (and is intended to remain) the only standard relating to this subject.

Detailed rules for the drafting of titles are given in the ISO/IEC Directives, Part 3, 1997, annex D.

5.3.2.2  SEQ H4L2SCL2 \h \r1 Styles

Names:
zzSTDTitle XE "zzSTDTitle" 

 XE "Styles:zzSTDTitle"  (document title on page 1 of the document)



zzCover XE "zzCover" 

 XE "Styles:zzCover"  (cover sheet)

Automatic numbering: no

5.3.2.3 Applying the style

Element inserted by the template.

5.3.2.4 Remarks

The title is generated from the data entered in the STD manager. Therefore, changes to the title shall be made only by changing the data in the STD manager; click on the “Doc Info” button (see 4.2) and add or change the data in the relevant dialogue box.

See the notes in 4.2.2.

5.3.3 Table of contents

5.3.3.1  SEQ H4L2SCL2 \h \r1 Drafting rules

 XE "Table of contents" The table of contents is an optional preliminary element, but is necessary if it makes the standard easier to consult. The table of contents shall be entitled “Contents” and shall list clauses and, if appropriate, subclauses with titles, annexes together with their status in parentheses, the bibliography, index(es), figures and tables. The order shall be as follows: clauses and subclauses with titles; annexes (including clauses and subclauses with titles if appropriate); the bibliography; index(es); figures; tables. All the elements listed shall be cited with their full titles. Terms in the “Terms and definitions” clause shall not be listed in the table of contents.

NOTE
When a new document is created, the table of contents is generated automatically in the document skeleton. It contains the title “Contents” (see 5.3.3.2) and the table of contents (see 1.1.1.3). If necessary, it can be reinserted by using the “Framework” button (see 4.4).

5.3.3.2 “Contents” title

5.3.3.2.1  SEQ H4L2SCL2 \h \r1 Style

 XE "Contents title" Name: zzContents XE "zzContents" 

 XE "Styles:zzContents" 
Automatic numbering: no

5.3.3.2.2 Applying the style

Use the “Framework” button (see 4.4).

5.3.3.2.3 Remarks

This style applies only to the title of the table of contents. The entries in the table of contents are styled “TOC” (see 1.1.1.3).

If for any reason, the title “Contents” has to be reinserted, together with the table of contents (see 1.1.1.3), use the “Framework” button (see 4.4). XE "Contents title:insertion of" 
5.3.3.3 Table of contents

5.3.3.3.1  SEQ H4L2SCL2 \h \r1 Styles

 XE "Table of contents" Names: TOC 1 to TOC 6, and TOC 9 XE "TOC 1" 

 XE "TOC 2" 

 XE "TOC 3" 

 XE "TOC 4" 

 XE "TOC 5" 

 XE "TOC 6" 

 XE "TOC 9" 

 XE "Styles:TOC 9" 

 XE "Styles:TOC 6" 

 XE "Styles:TOC 5" 

 XE "Styles:TOC 4" 

 XE "Styles:TOC 3" 

 XE "Styles:TOC 2" 

 XE "Styles:TOC 1" 
Automatic numbering: no

5.3.3.3.2 Applying the style

Use the “Framework” button (see 4.4).

5.3.3.3.3 Remarks

The table of contents is generated automatically. To update it, place the cursor anywhere in the table of contents and press F9.

It is not necessary to update the table of contents after inserting each element which needs to appear in the table of contents; you may wait if you prefer and press F9 once before you print or close the file. However, if the page numbers in the table of contents are replaced by the error message “Error! Bookmark not defined!”, update it as described above. XE "Table of contents:updating" 
Do not forget to update the table of contents when you have finished drafting your document and before you print it. Beware that the table of contents may not be up to date in drafts you receive.

Each of the entries, other than foreword and introduction (if present), consists of the clause or subclause number, a tabulation, the clause or subclause title and a tabulation followed by the corresponding page number (where this is known). The clause or subclause titles are entered at the same level in the table of contents as their heading style level [for example, clause titles (“Heading 1” style) are entered as a “TOC 1” style, subclause titles at level 1 (“Heading 2” style) are entered as “TOC 2” style, etc.]. The “TOC 9” style is reserved for unnumbered titles (foreword, introduction, bibliography and index).

By default, only headers up to level 3 will appear. If you wish to change this option, display the field codes (in the “Tools” menu, select the “Options...” command, choose the “View” tab and check the “Field codes” box) and replace «\o “1-3“» by «\o “1-4“» for 4 levels or «\o “1-2“» for two levels, etc. Do not change the other codes. If you prefer, you can also change the options by using the “Index and Tables...” command in the “Insert” menu (select the option “From template” and press the “Options” button). 

 XE "Table of figures:insertion of" To insert a table of figures XE "Table of figures" , type the title “Figures” at the bottom of the table of contents and apply the “Special” style. Format it to obtain the desired presentation. Place the cursor in a new “Normal” style paragraph under the title. In the “Insert” menu, choose the “Index and Tables...” command, then click on the “Table of Figures” tab. Choose the option “Figure” under “Caption label”. Under “Formats” choose the “From template” option. Press the “Options” button and in the “Table of Figures Options” dialogue box, select the “Style” option and “Figure title” from the list. Click twice on the “OK” button. Answer “No” to the question “Do you want to replace the selected table of figures”.

 XE "Table of tables:insertion of" To insert a table of tables XE "Table of tables" , type the title “Tables” at the bottom of the table of contents and apply the “Special” style. Format it to obtain the desired presentation. Place the cursor in a new “Normal” style paragraph under the title. In the “Insert” menu, choose the “Index and Tables...” command, then click on the “Table of Figures” tab. Choose the option “Table” under “Caption label”. Under “Formats” choose the “From template” option. Press the “Options” button and in the “Table of Figures Options” dialogue box, select the “Style” option and “Table title” from the list. Click twice on the “OK” button. Answer “No” to the question “Do you want to replace the selected table of figures”.

 XE "Table of contents:insertion of" If necessary, the table of contents can be reinserted, at the same time as the “Contents” title (see 1.1.1.2), using the “Framework” button (see 4.4).

5.3.4 Foreword

5.3.4.1  SEQ H4L2SCL2 \h \r1 Drafting rules

 XE "Foreword" The foreword shall appear in each standard. It shall not contain requirements, figures or tables.

NOTE
The foreword is automatically generated in the document skeleton when a new document is created. It consists of the “Foreword” title (see 1.1.2.2) followed by the foreword text (1.1.1.3).

5.3.4.2 “ SEQ H4L2SCL2 \h \r1 Foreword” title XE "Foreword title" 
5.3.4.2.1  SEQ H4L2SCL2 \h \r1 Style

xe “Foreword:title“Name: zzForeword XE "zzForeword" 

 XE "Styles:zzForeword" 
Automatic numbering: no

5.3.4.2.2 Applying the style

Element inserted by the template.

5.3.4.2.3 Remarks

This style applies only to the title of the foreword. The text given in the foreword is in the style “Foreword” (see 1.1.1.3).

The foreword is not numbered.

5.3.4.3 Foreword text SEQ H4L2SCL2 \h \r1 
5.3.4.3.1  SEQ H4L2SCL2 \h \r1 Style

xe “Foreword:text“Name: Foreword XE "Foreword" 

 XE "Styles:Foreword" 
Automatic numbering: no

5.3.4.3.2 Applying the style

Element inserted by the template.

5.3.4.3.3 Remarks

The text of the foreword is automatically generated in the document skeleton from the data entered in the STD manager. Therefore, changes to the text appearing in blue (see 4.1.4.2) shall be made only by changing the data in the STD manager; click on the “Doc Info” button (see 4.2) and add or change the data in the relevant dialogue box.

Text appearing in red (see 4.1.4.3) should be either completed or deleted. Complete the text with the following information, as necessary:

· an indication of any other international organization that has contributed to the preparation of the standard;

· a statement that the standard cancels and replaces other documents in whole or in part (see the procedure in 4.2.3);

· a statement of significant technical changes from the previous edition of the standard;

· the relationship of the standard to other standards or other documents;

· a statement specifying which annexes are normative and which are informative.

The foreword text is automatically regenerated every time the STD manager is run. Therefore, to avoid having to repeat the modifications to the text in red, change the modified foreword text  XE "Modified foreword text"  (i.e. that in red) to the “Special” style. When changes are made to data in the STD manager, the modified foreword text changed to the “Special” style will remain either before or after the automatically generated foreword text, depending on where it was initially, and the new automatically generated text can simply be deleted. 

5.3.5 Introduction

5.3.5.1  SEQ H4L2SCL2 \h \r1 Drafting rules

 XE "Introduction" The introduction is an optional preliminary element used, if required, to give specific information or commentary about the technical content of the standard, and about the reasons prompting its preparation. It shall not contain requirements.

The introduction shall not be numbered unless there is a need to create numbered subdivisions. In this case, it shall be numbered 0 with subclauses being numbered 0.1, 0.2, etc. This numbering has to be created manually since the “Introduction” style in not autonumbered. Any numbered figure, table, displayed formula or footnote shall be numbered normally beginning with 1.

NOTE
The title “Introduction” is automatically generated in the document skeleton when a new document is created. If necessary, it can be reinserted by using the “Framework” button (see 4.4).

5.3.5.2  SEQ H4L2SCL2 \h \r1 “Introduction” title

5.3.5.2.1  SEQ H4L2SCL2 \h \r1 Style

 XE "Introduction title" Name: Introduction XE "Introduction" 

 XE "Styles:Introduction" 
Automatic numbering: no

5.3.5.2.2 Applying the style

Use the “Framework” button (see 4.4).

5.3.5.2.3 Remarks

This style applies only to the title of the introduction. The text given in the introduction is in the style “Normal” (see 5.2.3).

If necessary, the “Introduction” title can be reinserted using the “Framework” button (see 4.4).

5.3.6 Basic clauses

5.3.6.1 “Scope” clause

 XE "Basic clauses" 

 XE "Scope clause" 

 XE "Clause:Scope" The “Scope” clause shall appear at the beginning of each standard and define without ambiguity the subject of the standard and the aspect(s) covered, thereby indicating the limits of applicability of the standard or particular parts of it. It shall not contain requirements.

The scope shall be succinct so that it can be used as a summary for bibliographic purposes.

It shall be worded as a series of statements of fact. Forms of expression such as “This International Standard specifies [establishes] [gives guidelines for] [defines terms] …” shall be used.

Statements of applicability of the standard shall be introduced by the wording “This International Standard is applicable to …” or “This part of ISO ... is applicable to …” as appropriate.

The title “Scope”, in a “Heading 1” style, is automatically generated in the document skeleton when a new document is created. If necessary, it can be reinserted using the “Framework” buttonxe “Framework button“ (see 4.4).

5.3.6.2 “Conformance” clause

 XE "Conformance clause" 

 XE "Clause:Conformance" The “Conformance” clause is only required in some standards in the Information technology field. Requirements concerning the “Conformance” clause are not covered by the ISO/IEC Directives, Part 3, 1997, but by ISO/IEC TR 10000‑1[3].

The title “Conformance”, in a “Heading 1” style,  can be inserted using the “Framework” buttonxe “Framework button“ (see 4.4).

5.3.6.3 “Normative references” clause

 XE "Normative references clause" 

 XE "Clause:Normative references" The “Normative reference(s)” clause is an optional element that gives a list of the normative documents to which reference is made in the standard in such a way as to make them indispensable for the application of the standard.

The title “Normative references”, in a “Heading 1” style, together with the introductory text for the list of normative references as well as two normative reference examples can be inserted using the “Framework” buttonxe “Framework button“ (see 4.4).

The list of normative references is introduced by a boilerplate text which is automatically generated using the data entered in the STD manager. Consequently, changes to the text appearing in black should only be made by changing the data in the STD manager; click on the “Doc Info” button (see 4.2) and add or change the data in the relevant dialogue box.

Text appearing in red (see 4.1.4.3) should be either completed or deleted.

In principle, the normative documents shall be International Standards published by ISO and/or IEC. Normative documents published by other bodies may be listed provided that

· the document is recognized by the ISO and/or IEC committee concerned as having wide acceptance and authoritative status as well as being publicly available,

· the ISO and/or IEC committee concerned has obtained the agreement of the authors or publishers (where known) of the document to its inclusion,

· the authors or publishers (where known) have also agreed to inform the ISO and/or IEC committee concerned of their intention to revise the document and of the points the revision will concern, and

· the ISO and/or IEC committee concerned undertakes to review the situation in the light of any changes in the referenced document.

Normative references shall be entered in the “RefNorm” style.xe “Normative reference“
Type 3 Technical Reports are not permitted to contain normative matter, and shall not contain “normative references”. They may, however, contain “references” which shall be entered in the “Special” style.

The list shall not include the following:

· documents that are not publicly available; 

· documents to which only informative reference is made; 

· documents which have merely served as references in the preparation of the standard.

Such documents may be listed in a bibliography (see 1.1.11).

Normative references shall be either dated (i.e. to a specific edition) or undated.

For dated references, each shall be given with its year of publication, or, in the case of enquiry or final drafts, with a dash together with a footnote “To be published.”, and full title. Subsequent amendments to, or revisions of, dated references will need to be incorporated by amendment of the standard referring to them. References to specific divisions or subdivisions, tables and figures of another document shall always be dated.

Undated references may be made only to a complete document or a part thereof and only in the following cases:

a)
if it is accepted that it will be possible to use all future changes of the document referred to for the purposes of the referring standard;

b)
for informative references.

Undated references shall be understood to include all amendments to and revisions of the quoted publication. The year of publication or dash shall not be given for undated references. When an undated reference is to all parts of a standard, the publication number shall be followed by the indication “(all parts)” and the general title of the series of parts (i.e. the introductory and main elements).

EXAMPLE

ISO 31 (all parts), Quantities and units.

ISO 10241:1992, International terminology standards — Preparation and layout.

5.3.6.4 “Terms and definitions” clause

5.3.6.4.1 General

 XE "Terms and definitions clause" 

 XE "Clause:Terms and definitions" The “Term(s) and definition(s)” clause is an optional element giving definitions necessary for the understanding of certain terms used in the standard. 

The title “Terms and definitions”, in a “Heading 1” style, together with the introductory text of the list of terms and definitions as well as two examples of terms and definitions can be inserted using the “Framework” buttonxe “Framework button“ (see 4.4).

The list of terms and definitions is introduced by a boilerplate text which is automatically generated using the data entered in the STD manager. Consequently, changes to the text appearing in black should only be made by changing the data in the STD manager; click on the “Doc Info” button (see 4.2) and add or change the data in the relevant dialogue box.

Text appearing in red (see 4.1.4.3) should be either completed or deleted.

Rules for the drafting and presentation of terms and definitions are given in the ISO/IEC Directives, Part 3, 1997, annex C, and in ISO 10241[4].

The series of styles for terms and definitions is given in 1.1.3.4.2 to 1.1.3.4.4.

Although the presentation of a term and its reference number resembles that of a subclause, they do not constitute a subclause and are not subject to the same rules (it is permissible, for example, to have a single term). Terms shall not be listed in the table of contents. Subclauses with titles may be present in the “Terms and definitions” clause; if so, the style “Subclause with title” (see 5.2.2.2) may be used but only if the subdivision is homogeneous and if no term is at the same level as a subclause with a title.

5.3.6.4.2  SEQ H4L2SCL2 \h \r1 Term reference number

5.3.6.4.2.1  SEQ H4L2SCL2 \h \r1 Style

 XE "Term reference number" Name: TermNum XE "TermNum" 

 XE "Styles:TermNum" 
Automatic numbering: no

5.3.6.4.2.2 Applying the style

Two alternative methods can be used.

l) Adapt the examples inserted using the “Framework” button.

m) Click on the “Definition” button; type in the reference number of the term; click on the “OK” button.

5.3.6.4.2.3 Remarks

Hitting return after having entered a term reference number will put the cursor in a new paragraph in the style ‘‘Term(s)”.

All terms shall be numbered. If only a single term is given, it shall be numbered.

5.3.6.4.3  SEQ H4L2SCL2 \h \r1 Term

5.3.6.4.3.1  SEQ H4L2SCL2 \h \r1 Style

 XE "Term" Name: Term(s) XE "Term(s)" 

 XE "Styles:Term(s)" 
Automatic numbering: no

5.3.6.4.3.2 Applying the style

Two alternative methods can be used.

n) Adapt the examples inserted using the “Framework” button.

o) Hit return after having entered the term reference number.

5.3.6.4.3.3 Remarks

The preferred term shall be placed on a new line, after its reference number, starting with a lower-case letter except for any capital letters required by the normal written form in running text.

Hitting return after you have entered a term will put the cursor in a new paragraph in the style ‘‘Definition”. If you need to insert one or more synonyms XE "Synonyms:how to enter" , hit return and then select the ‘‘Term(s)” style from the Style drop-down list before typing in the synonym (see the following example).

EXAMPLE

3.2
term

synonym

text of the definition

Use the style ‘‘Term(s)” for terms in a “Terms and definitions” clause or in a vocabulary.

5.3.6.4.4 Definition XE "Definition" 
5.3.6.4.4.1 Style

Name: Definition XE "Styles:Definition" 
Automatic numbering: no

5.3.6.4.4.2 Applying the style

Two alternative methods can be used.

p) Adapt the examples inserted using the “Framework” button.

q) Hit return after having entered the term.

5.3.6.4.4.3 Remarks

The definition shall be placed on a new line, starting with a lower-case letter, except for any capital letters required by the normal written form in running text, and shall not be followed by a full-stop.

Hitting return after you have entered a definition will put the cursor in a new paragraph in the style ‘‘Normal”. 

5.3.6.5 “Symbols and abbreviated terms” clause

 XE "Symbols and abbreviated terms clause" 

 XE "Clause:Symbols and abbreviated terms" The “Symbols and abbreviated terms” clause is an optional element giving a list of the symbols and abbreviated terms necessary for the understanding of the standard.

The title “Symbols and abbreviated terms”, in a “Heading 1” style, can be inserted using the “Framework” buttonxe “Framework button“ (see 4.4).

Unless there is a need to list symbols in a specific order to reflect technical criteria, all symbols should be listed in alphabetical order in the following sequence:

—
upper case Latin letter followed by lower case Latin letter (A, a, B, b, etc.);

—
letters without indices preceding letters with indices, and with letter indices preceding numerical ones (B, b, C, Cm, C2, c, d, dext, dint, d1, etc.);

—
Greek letters following Latin letters (Z z ( ( ( ( … ( ( etc.);

—
any other special symbols.

For convenience, this element may be combined with the “Terms and definitions” clause (see 1.1.3.4) in order to bring together terms and their definitions, symbols, abbreviated terms and perhaps units under an appropriate composite title, for example “Terms, definitions, symbols, units and abbreviated terms”.

5.3.6.6 “Requirements” clause

 XE "Requirements clause" 

 XE "Clause:Requirements" The “Requirements” clause is an optional element.

The title “Requirements”, in a “Heading 1” style, can be inserted using the “Framework” buttonxe “Framework button“ (see 4.4).

If present, it shall contain the following:

a)
all characteristics relevant to the aspect(s) of the product(s), pro​cess(es) or service(s) covered by the standard, either explicitly or by reference;

b)
the required limiting values of quantifiable characteristics;

c)
for each requirement, either a reference to the test method for deter​mining or verifying the values of the characteristic, or the test method itself (see 1.1.3.8).

A clear distinction shall be made between requirements, statements and recommendations.

Contractual requirements concerning claims, guarantees, covering of expenses, etc. shall not be included.

In some product standards, it may be necessary to specify that the product shall be accompanied by warning notices or by instructions to the user or installer, and to specify their nature. On the other hand, requirements concerning use or installation as such shall be included in a separate part or a separate standard since they are not requirements applicable to the product itself.

Standards listing characteristics for which suppliers are required to state values that are not specified by the standard itself shall specify how such values are to be measured and stated.
5.3.6.7 “Sampling” clause

 XE "Sampling clause" 

 XE "Clause:Sampling" The “Sampling” clause is an optional element specifying the conditions and methods of sampling, as well as the method for the preservation of the sample(s).

The title “Sampling”, in a “Heading 1” style, can be inserted using the “Framework” button (see 4.4).

This element may appear at the beginning of the element “Test methods” (see 1.1.3.8).

5.3.6.8 “Test methods” clause

 XE "Test methods clause" 

 XE "Clause:Test methods" The “Test methods” clause is an optional element giving all the instructions concerning the procedure for determining the values of characteristics, or for checking conformity to stated requirements, and for ensuring the reproducibility of the results. If appropriate, tests shall be identified to indicate whether they are type tests, routine tests, sampling tests and so on.

The title “Test methods”, in a “Heading 1” style, can be inserted using the “Framework” button (see 4.4).

Instructions relating to test methods may be subdivided in the following order (where appropriate):

a)
principle;

b)
reagents or materials;

c)
apparatus;

d)
preparation and preservation of test samples and test pieces;

e)
procedure;

f)
expression of results, including method of calculation and precision of the test method;

g)
test report.

For drafting of methods of chemical analysis, see ISO 78‑2[5].  Much of ISO 78‑2 is also applicable to test methods for products other than chemical products.

Test methods may be presented in separate clauses, or be incorporated in the “Requirements” clause (see 1.1.3.6), or be presented as annexes or separate parts. A test method shall be prepared as a separate standard if it is likely to be referred to in a number of other standards.

5.3.6.9 “Classification and designation” clause

 XE "Classification and designation clause" 

 XE "Clause:Classification and designation" The “Classification and designation” clause is an optional element which may establish a system of classification, designation (see the ISO/IEC Directives, Part 2[6]) and/or coding of products, processes or services that conform to stated require​ments.

The title “Classification and designation”, in a “Heading 1” style, can be inserted using the “Framework” buttonxe “Framework button“ (see 4.4).

For convenience, this element may be combined with the element “Requirements” (see 1.1.3.6).

5.3.6.10 “Marking, labelling and packaging” clause

 XE "Marking, labelling and packaging clause" 

 XE "Clause:Marking, labelling and packaging" The “Marking, labelling and packaging” clause is an optional element which may specify the marking of a product (for example, manufacturer’s or vendor’s trade mark; model or type number). It may include requirements for the labelling and/or packaging of the product (for example, handling instructions, hazard warnings, date of manufacture). (See the ISO/IEC Directives, Part 2.)

The title “Marking, labelling and packaging”, in a “Heading 1” style, can be inserted using the “Framework” button (see 4.4).

Symbols specified for marking shall be in conformity with relevant International Standards.

The clauses “Classification and designation” (see 1.1.3.9) and “Marking, labelling and packaging” may be supplemented by an informative annex giving an example of ordering information.

5.3.7 Notes integrated in the text

5.3.7.1 Drafting rules

 XE "Notes integrated in the text" Notes integrated in the text of a standard shall only be used for giving additional information intended to assist the understanding or use of the standard and shall not contain provisions to which it is necessary to conform in order to be able to claim compliance with the standard.

Notes should preferably be placed at the end of the clause or subclause, or after the paragraph, to which they refer.

A single note in a clause or subclause shall be preceded by “NOTE”, placed at the beginning of the first line of the text of the note. When several notes occur within the same clause or subclause, they shall be designated “NOTE 1”, “NOTE 2”, “NOTE 3”, etc.

5.3.7.2 Style

Name: Note XE "Note" 

 XE "Styles:Note" 
Automatic numbering: no

5.3.7.3 Applying the style

Click on the “Note” button of the “Insert” toolbar.

5.3.7.4 Remarks

When a note is inserted using the “Note” button of the “Insert” toolbar, the text “NOTE” is generated automatically followed by a tabulation. If the note is to be numbered (see 1.1.4.1), insert the number, preceded by a nonbreaking space (combination of keys Ctrl+Shift+space bar), before the tabulation.

In this stylesheet, notes are in a smaller font size than that of the “Normal” style so that the extent of the note can be determined easily.

Hitting return after you have entered a note will put the cursor in a new paragraph in the style “Normal”.

5.3.8 Examples integrated in the text

5.3.8.1 Drafting rules

 XE "Examples integrated in the text" Examples integrated in the text of a standard shall only be used for giving additional information intended to assist the understanding or use of the standard and shall not contain provisions to which it is necessary to conform in order to be able to claim compliance with the standard.

Examples should preferably be placed at the end of the clause or subclause, or after the paragraph, to which they refer.

A single example in a clause or subclause shall be preceded by “EXAMPLE”, placed at the beginning of the first line of the text of the example. When several examples occur within the same clause or subclause, they shall be designated “EXAMPLE 1”, “EXAMPLE 2”, “EXAMPLE 3”, etc.

5.3.8.2 Style

Name: Example XE "Example" 

 XE "Styles:Example" 
Automatic numbering: no

5.3.8.3 Applying the style

Click on the “Example” button in the “Insert” toolbar.

5.3.8.4 Remarks

When an example is inserted using the “Example” button of the “Insert” toolbar, the text “EXAMPLE” is generated automatically followed by a tabulation. If the example is to be numbered (see 1.1.5.1), insert the number, preceded by a nonbreaking space (combination of keys Ctrl+Shift+space bar), before the tabulation. XE "Examples integrated in the text:numbering of" 
In this stylesheet, examples are in a smaller font size than that of the “Normal” style so that the extent of the example can be determined easily.

Hitting return after you have entered an example will put the cursor in a new paragraph in the style “Normal”.

5.3.9 Footnotes to the text

5.3.9.1 Drafting rules

 XE "Footnotes to the text" Footnotes to the text give additional information; their use shall be kept to a minimum. They shall not contain requirements.

Footnotes to the text shall be placed at the foot of the relevant page and be separated from the text by a short thin horizontal line on the left of the page.

Footnotes to the text shall normally be distinguished by arabic numerals, beginning with 1, followed by one parenthesis and forming a continuous numerical sequence throughout the document: 1), 2), 3), etc. The footnotes shall be referred to in the text by inserting the same numerals, as superscripts, after the word or sentence in question: 1) 2) 3) etc.

5.3.9.2 Style

Name: Footnote XE "Styles:Footnote" 
Automatic numbering: yes

5.3.9.3 Applying the style

Click on the “FootNote” button in the “Insert” toolbar.

5.3.9.4 Remarks

Position the cursor at the place where the footnote reference is to be inserted, then click on the “FootNote” button and type in the footnote text in the “Footnotes” dialogue box. XE "Footnote references" 
To make multiple references to the same footnote, ensure that the footnote to be referenced has been inserted using the “FootNote” button. In order to make further references to the same footnote, position the cursor at the place where the footnote reference is to be inserted, then choose the “Insert”  “Cross-reference” command. In the “Cross-reference” dialogue box, select the “Footnote” option under “Reference type” and the “Footnote number” option under “Insert reference to”. In the list entitled “For which footnote” select the footnote which you want to reference. Click on the “Insert” button then the “Close” button. In the document, with the cursor positioned after the inserted footnote reference, add a closing parenthesis. Select both the footnote reference and the closing parenthesis, and select the “Footnote Reference” style from the Style drop-down list.

The footnote reference is in the “Footnote Reference” style.

5.3.10 Figures

5.3.10.1 Drafting rules

 XE "Figures" Figures should be used wherever appropriate to present information in an easily comprehensible form. It shall be possible to refer to each figure explicitly within the text.

One level of subdivision only is permitted [e.g. Figure 1 may be subdivided as a), b), c), etc.].

Figures shall be in the form of line drawings. The use of computer-generated drawings is preferable. Photographs may be used only if it is not possible to convert them into line drawings.

5.3.10.2 Drawings

5.3.10.2.1 Drafting rules

 XE "Drawings" Letter symbols used in figures to represent general cases of angular or linear quantities shall be in accordance with ISO 31‑1[7], subscripts being used where necessary to distinguish between different applications of a given symbol.

For a series of symbols indicating various lengths on a drawing use l1, l2, l3, etc. and not, for instance, A, B, C, etc. or a, b, c, etc.

Lettering on drawings shall be in accordance with ISO 3098‑1[8]. Inclined (italic) letters shall be used for

—
symbols for quantities,

—
subscripts representing symbols for quantities, and

—
symbols representing numbers.

The vertical (upright) style shall be used for all other lettering.

In artwork, it is recommended that labelling be substituted by item references (see ISO 6433[9]) wherever possible.

Technical drawings shall be prepared in accordance with relevant ISO standards (see the ISO/IEC Directives, Part 3, 1997, A.8).

Graphical symbols for use on equipment shall be in accordance with IEC 60417[10] and ISO 7000[11].

Diagrams, such as circuit diagrams and connection diagrams, for example for test circuits, shall be prepared in accordance with IEC 61082[12]. Graphical symbols used in schematic diagrams shall be in accordance with IEC 60617[13] and ISO 14617[14]. Reference designations and signal designations shall be in accordance with IEC 61346[15] and IEC 61175[16] respectively.

5.3.10.2.2 Style

Name: Normal XE "Normal" 

 XE "Styles:Normal" 
Automatic numbering: no

5.3.10.2.3 Applying the style

Select the “Normal” style from the Style drop-down list or use the keyboard shortcut Ctrl+Shift+N.

5.3.10.2.4 Remarks

Drawings and any statements concerning the dimensions used shall be placed in “Normal” style paragraphs (see 5.2.3). Use the formatting commands of your word processor to align the paragraphs to the desired position (for example, for the statement concerning dimensions, use the formatting commands to align it to the right-hand margin and to reduce the font size by one point). See the example in 1.1.7.5.4.

To insert a figure, position the cursor in an empty paragraph at the place where you want the artwork to be, select the ‘‘Insert” “Picture” “From File…” command. In the ‘‘Insert Picture” dialogue box, type in the file name in the “File name” field or select it from the list. (If the file name does not appear in the list, select another disk drive, directory or folder, or type the file name in the “File name” field and click on the “Find Now” button to find the file in another location.) Select the “Link to File” check box, then deselect the “Save with document” check box. XE "Figure:inserting a graphics file" 

 XE "Linking graphics files" 
If the source file of the artwork is not available, then only an empty box appears on the screen. If the source file of the artwork is available, then the word processor displays the artwork based on the data from the source file but does not store the artwork as part of the text file. Each time the word processor shows the artwork, the screen image is produced from the source file. Consequently, it takes longer to display the linked file than it would if it were directly stored in the text file but, by proceeding in this manner, the size of the document file does not substantially increase.

When sending files to the ISO Central Secretariat, XE "Sending files to the ISO Central Secretariat"  it is acceptable to insert the artwork in the text file as described above, but in addition please always include a copy of each graphics file as a separate file.

5.3.10.3 Notes to figures

5.3.10.3.1 Drafting rules

 XE "Notes:to figures" Notes to figures shall be treated independently from notes integrated in the text. They shall be located above the title of the relevant figure and shall precede figure footnotes. A single note in a figure shall be preceded by “NOTE”, placed at the beginning of the first line of the text of the note. When several notes occur in the same figure, they shall be designated “NOTE 1”, “NOTE 2”, “NOTE 3”, etc. A separate numbering sequence shall be used for each figure.

Notes to figures shall not contain requirements. Any requirements relating to the content of a figure shall be given in the text, in a footnote to the figure or as a paragraph between the figure and its title. It is not necessary that notes to figures are referred to.

5.3.10.3.2 Style

Name: Note XE "Note" 

 XE "Styles:Note" 
Automatic numbering: no

5.3.10.3.3 Applying the style

Click on the “Note” button in the “Insert” toolbar.

5.3.10.3.4 Remarks

See 1.1.4.4.

5.3.10.4 Figure footnotes

5.3.10.4.1 Drafting rules

 XE "Figure footnotes" Footnotes to figures shall be treated independently from footnotes to the text. They shall be located immediately above the title of the relevant figure, and shall follow figure notes.

Footnotes to figures shall be distinguished by superscript lower-case letters, beginning with “a”. The footnotes shall be referred to in the figure by inserting the same superscript lower-case letter.

Footnotes to figures may contain requirements. As a consequence, it is particularly important when drafting the text of the figure footnote to distinguish clearly between different types of provision by using the appropriate verbal forms (see the ISO/IEC Directives, Part 3, 1997, annex E).

5.3.10.4.2 Style

Name: Figure footnote XE "Figure footnote" 

 XE "Styles:Figure footnote" 
Automatic numbering: no

5.3.10.4.3 Applying the style

Select the “Figure Footnote” style from the Style drop-down list.

5.3.10.4.4 Remarks

Position the cursor in an empty paragraph at the place where you want the figure footnote to be, select the style ‘‘Figure footnote” from the Style drop-down list, and then type in the footnote identification letter, insert a tabulation and type in the text of the footnote. Select the footnote identification letter that you have just inserted, then from the “Format” menu select “Font...” and in the “Font...” tab set the “Size” to 8 pt. Click on the tab “Character Spacing” and in the “Position” drop-down list select “Raised” and set the value to 3 pt. Click on “OK”. XE "Figure footnote:references" 
Hitting return after you have entered a figure footnote will put the cursor in a new paragraph in the style “Figure footnote”.

5.3.10.5 Figure titles

5.3.10.5.1 Drafting rules

 XE "Figure titles" Figures shall be numbered with arabic numerals, beginning with 1. This numbering shall be independent of the numbering of the clauses and of any tables. A single figure shall be designated “Figure 1”. The numbering shall be continuous up to but excluding any annexes. Numbers given to the figures of an annex shall be preceded by the letter designating that annex followed by a full-stop. The numbering shall start afresh with each annex.

The title shall be centred horizontally below the figure.

5.3.10.5.2 Style

Name: Figure title XE "Figure title" 

 XE "Styles:Figure title" 
Automatic numbering: yes

5.3.10.5.3 Applying the style

Position the cursor in an empty paragraph in “Normal” style or at the beginning of the paragraph where the style is to be applied; click on the “Figure title” button of the “Insert” toolbar; if necessary, type the title and click on the “OK” button.

5.3.10.5.4 Remarks

If a figure title is restyled to any other style, the text ‘‘Figure x —” remains and will need to be deleted if it is not applicable.

If for any reason the figure number is not correct, it can be updated using the F9 key.

The use of figure titles shall be uniform.

Hitting return after you have entered a figure title will put the cursor in a new paragraph in the style ‘‘Normal”.

EXAMPLE

Dimensions in millimetres

PLACE FIGUREa HEREb
A paragraph containing a requirement.

NOTE  
Figure note.

a
Figure footnote.

b
Figure footnote.

Figure 1 — Figure title

5.3.11 Tables

5.3.11.1 Drafting rules

 XE "Tables" Tables should be used wherever appropriate to present information in an easily comprehensible form. It shall be possible to refer to each table explicitly within the text.

A table within a table is not permitted. Subdivision of a table into subsidiary tables is not permitted.

5.3.11.2 Table titles

5.3.11.2.1 Drafting rules

 XE "Table titles" Tables shall be numbered with arabic numerals, beginning with 1. This numbering shall be independent of the numbering of the clauses and of any figures. A single table shall be designated “Table 1”. The numbering shall be continuous up to but excluding any annexes. Numbers given to the tables of an annex shall be preceded by the letter designating that annex followed by a full-stop. The numbering shall start afresh with each annex.

The title shall be centred horizontally above the table.

5.3.11.2.2 Style

Name: Table title XE "Table title" 

 XE "Styles:Table title" 
Automatic numbering: yes

5.3.11.2.3 Applying the style

Position the cursor in an empty paragraph in “Normal” style or at the beginning of the paragraph where the style is to be applied; click on the “Table title” button of the “Insert” toolbar; if necessary, type the title and click on the “OK” button.

5.3.11.2.4 Remarks

If a table title is restyled to any other style, the text ‘‘Table x —” remains and will need to be deleted if it is not applicable.

If for any reason the table number is not correct, it can be updated using the F9 key.

The use of table titles shall be uniform.

Hitting return after you have entered a table title will put the cursor in a new paragraph in the style ‘‘Normal”.

As an exception to the rules given in the ISO/IEC Directives, Part 3, when a table is continued over two or more pages, it is not necessary to repeat the table number on each page after the first if your word processor does not allow you to do so automatically. XE "Tables continued over two or more pages:repetition of title" 
5.3.11.3 Table content

5.3.11.3.1 Drafting rules

 XE "Table content" The first word in the heading of each column shall begin with a capital letter. The units used in a given column shall generally be indicated under the column heading. See example 1.

EXAMPLE 1

Type
Linear density

kg/m
Inside 
diameter
mm
Outside
diameter
mm






As an exception to this rule, when all units are the same, a suitable statement shall instead be placed above the right-hand corner of the table. See example 2.

EXAMPLE 2

Dimensions in millimetres

Type
Length
Inside diameter
Outside diameter






The presentation shown in example 3 is not permitted and shall be altered as shown in example 4.

EXAMPLE 3

Types

Dimensions
A
B
C






EXAMPLE 4

Dimensions
Types


A
B
C






When a table is continued over two or more pages, the column headings shall be repeated on all pages after the first (see the procedure in 1.1.8.3.4).

5.3.11.3.2 Styles

Names:
Body text to Body text 3 XE "Body text" 

 XE "Body text 2" 

 XE "Body text 3" 

 XE "Styles:Body text 2" 

 XE "Styles:Body text 3" 

 XE "Styles:Body text" 
Automatic numbering: no

5.3.11.3.3 Applying the style

Select the appropriate style from the Style drop-down list.

5.3.11.3.4 Remarks

The “Normal” style is not appropriate for tables because the text touches the upper border of the table cells. Therefore, the “Body text” styles have been defined to centre text vertically in the table cells. The font sizes of the styles are as follows:

Body text: 10 pt

Body text 2: 9 pt

Body text 3: 8 pt

The appropriate style should be selected in relation to the table content.

Use the “Bold” or “Italic” formatting button of your word processor to produce the required formatting; do not use a bold or sloping font.

Create a table using the table functionality of your word processor. As a rule, do not insert large tables from spreadsheets as images or objects. Insert them preferably as a table or as text in the text file (for the way in which to proceed, consult a Microsoft Word manual). Then, convert all the data to a table, if they are not already in this format, and apply the appropriate styles to the different table elements. Contact the ISO Central Secretariat if you have any styling problems using the word processor.

Any statement concerning the dimensions used should be placed in a “Normal” style paragraph. Use the formatting command of your word processor to align the paragraph with the right-hand side of the table, and to reduce the font size by one point.

When a table is continued over two or more pages, select the column heading(s) on the first page and, then select the “Headings” command under the “Table” menu to repeat automatically the heading(s) on the following pages.

It is not possible to use the styles “Heading 1” to “Heading 6”, and “a2” to “a6” in tables. 

5.3.11.4 Notes to tables

5.3.11.4.1 Drafting rules

 XE "Notes:to tables" Notes to tables shall be treated independently from notes integrated in the text. They shall be located within the frame of the relevant table and shall precede table footnotes. A single note in a table shall be preceded by “NOTE”, placed at the beginning of the first line of the text of the note. When several notes occur in the same table, they shall be designated “NOTE 1”, “NOTE 2”, “NOTE 3”, etc. A separate numbering sequence shall be used for each table.

Notes to tables shall not contain requirements. Any requirements relating to the content of a table shall be given in the text, in a footnote to the table or as a paragraph within the table. It is not necessary that notes to tables are referred to.

5.3.11.4.2 Style

Name: Note XE "Note" 

 XE "Styles:Note" 
Automatic numbering: no

5.3.11.4.3 Applying the style

Click on the “Note” button of the “Insert” toolbar.

5.3.11.4.4 Remarks

For tables with more than one column, it is necessary to merge the cells in which the table notes appear.

See also 1.1.4.4.

5.3.11.5 Table footnotes

5.3.11.5.1 Drafting rules

 XE "Table footnotes" Footnotes to tables shall be treated independently from footnotes to the text. They shall be located within the frame of the relevant table, and shall follow table notes.

Footnotes to tables shall be distinguished by superscript lower-case letters, beginning with “a”. The footnotes shall be referred to in the table by inserting the same superscript lower-case letter.

Footnotes to tables may contain requirements. As a consequence, it is particularly important when drafting the text of the table footnote to distinguish clearly between different types of provision by using the appropriate verbal forms (see the ISO/IEC Directives, Part 3, 1997, annex E).

5.3.11.5.2 Style

Name: Table footnote XE "Table footnote" 

 XE "Styles:Table footnote" 
Automatic numbering: no

5.3.11.5.3 Applying the style

Select the “Table footnote” style from the Style drop-down list.

5.3.11.5.4 Remarks

Position the cursor in an empty paragraph in the table cell where you want the table footnote to be, select the “Table footnote” style in the Style drop-down list and type in the identification letter of the footnote. Then insert a tabulation (key combination: Ctrl+Tab) and type in the footnote text.

To reduce the size of the identification letter and to place it as a superscript, select it, then apply the “TableFootNoteXref” character style from the Style drop-down list. Proceed in the same manner for each table footnote.

For tables with more than one column, it is necessary to merge the cells in which the table footnotes appear.

Hitting return after you have entered a table footnote will put the cursor in a new paragraph in the style ‘‘Table footnote”.

EXAMPLE 

Dimensions in millimetres

Type
Length
Inside diameter
Outside diameter


l1 a
d1
a


l2
d2 b


A paragraph containing a requirement.

NOTE 1 
Table note.

NOTE 2 
Table note.

a
Table footnote.

b
Table footnote.

5.3.12 Cross-references

5.3.12.1 Cross-references to terms defined in the document

 XE "Cross-references" 

 XE "Cross-references:to terms defined in the document" Use the character style “Defterms”  XE "Defterms" 

 XE "Styles:Defterms" from the Style drop-down list to identify all cross-references in the document to terms defined in the “Terms and definitions” clause.

5.3.12.2 Cross-references to a normative document

 XE "Cross-references:to a normative document" Use the character style “ExtXref”  XE "ExtXref" 

 XE "Styles:ExtXref" from the Style drop-down list to identify in the document all cross-references to normative references defined in the “Normative references” clause.

5.3.12.3 Cross-references to numbered elements

 XE "Cross-references:to numbered elements" It is possible to cross-reference automatically most automatically numbered elements using the “Insert” “Cross-reference…” command and by selecting the appropriate category of cross-reference. See 1.1.6.4 and 1.1.11.3, for example, for how to cross-reference a footnote to the text or a bibliographic reference respectively.

NOTE 1
It is our experience that Word does not always manage cross-references correctly; take care that cross-references are up to date in drafts that you receive.

NOTE 2
Figures and tables are not elements which can be automatically cross-referenced.

NOTE 3
In certain cases, it is necessary to type in the term corresponding to the element (for example “clause”, “list item”, etc.).

5.3.13 Displayed mathematical and chemical formulae

5.3.13.1 Drafting rules

 XE "Displayed mathematical and chemical formulae" Equations between quantities are preferred to equations between numerical values (see the ISO/IEC Directives, Part 3, 1997, 6.6.9.1). Equations shall be expressed in mathematically correct form, the variables being represented by letter symbols the meanings of which are explained in connection with the equations, unless they appear in a “Symbols and abbreviated terms” clause (see the ISO/IEC Directives, Part 3, 1997, 6.3.2). Descriptive terms or names of quantities shall not be arranged in the form of an equation.

If it is necessary to number some or all of the formulae in a standard in order to facilitate cross-reference, arabic numbers in parentheses shall be used, beginning with 1. The numbering shall be consecutive and independent of the numbering of clauses, tables and figures.

Numbers given to the formulae of an annex shall be preceded by the letter designating that annex followed by a full-stop. The numbering shall start afresh with each annex.

The International System of units (SI) as set out in ISO 31[7] shall be used. Symbols for quantities shall be chosen, wherever possible, from the various parts of ISO 31 and IEC 60027[17]. For further guidance on application, see ISO 1000[18].

The units in which any values are expressed shall be indicated.

The decimal sign shall be a comma on the line in all language versions of International Standards.
For clarity, the symbol ( rather than a point shall be used to indicate multiplication of numbers and numerical values.
If a value less than 1 is written in decimal form, the decimal sign shall be preceded by a zero.
For further information, see the ISO/IEC Directives, Part 3, 1997, 6.6.7 to 6.6.10.

5.3.13.2 Style

Name: Formula XE "Formula" 

 XE "Styles:Formula" 
Automatic numbering: no

5.3.13.3 Applying the style

Click on the “Formula” button of the “Insert” toolbar.

5.3.13.4 Remarks

The “Formula” button of the “Insert” toolbar applies the “Formula” style to the paragraph where the cursor is placed and then starts the Microsoft Equation 3.0 supplied with Word 97. This style is reserved for displayed formulae.

If you want to number a formula XE "Numbering a displayed formula" 

 XE "Displayed mathematical and chemical formulae:numbering" , after having closed Microsoft Equation 3.0, insert a tabulation after the formula, then type in the number of the formula in parentheses.

Hitting return after you have entered a displayed formula will put the cursor in a new paragraph in the style “Normal”.

Customize Microsoft Equation 3.0 using the parameters given in the ITSIG Guidexe “ITSIG Guide“ [19]. XE "Microsoft Equation Editor 3.0 parameters" 

 XE "ITSIG Guide" 
For lists of variables,  XE "List of variables, styles to use for" use the “Normal” style for the word “where” and the “Special” style for each variable. Enter the variable and insert a tabulation before the description. To obtain the correct alignment, use the following paragraph format:

· left indentation: 20 pt;

· first line hanging: 20 pt (if necessary, increase the indentation by increments of 20 pt).

5.3.14 Bibliography

5.3.14.1 Drafting rules

 XE "Bibliography" A bibliography, if present, shall appear after the last annex.

The following documents may be listed in a bibliography:

—
documents that are not publicly available;

—
documents to which only informative reference is made;

—
documents which have merely served as references in the preparation of the standard.

The relevant rules set out in ISO 690[20] shall be followed.

5.3.14.2 Title “Bibliography”

5.3.14.2.1 Style

 XE "Title \“Bibliography\”" Name: zzBiblio XE "zzBiblio" 

 XE "Styles:zzBiblio" 
Automatic numbering: no

5.3.14.2.2 Applying the style

Use the “Framework” buttonxe “Framework button“ (see 4.4).

5.3.14.2.3 Remarks

Position the cursor in an empty “Normal” style paragraph in the location where you want to introduce the bibliography, click on the “Framework” button, select “Bibliography”, click on the “Add” button, then click on the “OK” button. 

This style applies only to the title of the bibliography. Each reference in the bibliography is styled “bibliography” (see 1.1.11.3).

5.3.14.3 Bibliographic references

5.3.14.3.1 Style

 XE "Bibliographic references" Name: bibliography XE "bibliography" 

 XE "Styles:bibliography" 
Automatic numbering: yes

5.3.14.3.2 Applying the style

Select the style from the Style drop-down list.

5.3.14.3.3 Remarks

Each reference is numbered with arabic numbers in square brackets. (These numbers can be used for cross-referencing elsewhere in the document.) The references may be given in numerical order or in the order of appearance in the text.

To insert a cross-reference to a bibliographic reference, ensure first that the reference has been inserted using the “bibliography” style. Position the cursor at the place where the cross-reference is to be inserted. In the “Insert” menu select “Cross-reference...”. In the “Cross-reference” dialogue box select under “Reference type:” “Numbered item” and select under “Insert reference to:” “Paragraph number”. In the list “For which numbered item” select the bibliographic reference to which you want to refer. Click on the “Insert” button and then on the “Close” button. Select the cross-reference that you have just inserted, then from the “Format” menu select “Font...” and in the “Font...” tab set the “Size” to 8 pt. Click on the tab “Character Spacing” and in the “Position” drop-down list select “Raised” and set the value to 3 pt. Click on “OK”.

5.3.15 Index

5.3.15.1 Drafting rules

 XE "Index" Index(es), if present, shall appear as the last element.

5.3.15.2 Title “Index”

5.3.15.2.1 Style

 XE "Title \“Index\”" Name: zzIndex XE "zzIndex" 

 XE "Styles:zzIndex" 
Automatic numbering: no

5.3.15.2.2 Applying the style

Use the “Framework” button (see 4.4).

5.3.15.2.3 Remarks

Position the cursor in an empty “Normal” style paragraph in the location where you want to introduce the index, click on the “Framework” button, select “Index”, click on the “Add” button, then click on the “OK” button. 

This style applies only to the title of the index. Each entry in the index is styled “Index 1” (see 1.1.12.3).

5.3.15.3 Index entries

5.3.15.3.1 Style

 XE "Index entries" Name: Index 1 XE "Index 1" 

 XE "Styles:Index 1" 
Automatic numbering: no

5.3.15.3.2 Applying the style

Automatically applied to index entries.

5.3.15.3.3 Remarks

Indexes XE "Indexes:generation of"  should preferably be generated automatically. Authors of non-terminology standards wanting to introduce indexes are invited to contact the ISO Central Secretariat to discuss the best means of generating an index.

For multilingual documents giving terminology, the indexes cannot be generated automatically because word processors are unable to manage more than one index without the use of special macros.

Do not forget to update the index when you have finished drafting your document and before you print it: put the cursor anywhere in the index and press the F9 key. Beware that the index may not be up to date in drafts you receive.

Before inserting an index using the “Index and Tables...” command in the “Insert” menu, it is essential to add a new section to prevent the page setup of the previous sections from being altered. Therefore, to insert an index proceed as follows. Place the cursor at the end of the page preceding the title “Index” (see 1.1.12.2.3) and from the “Insert” menu select “Break…”. In the “Break” dialogue box, select “Next page” under the option “Section breaks”. To correct the headers and footers in this new section position the cursor somewhere in the index and from the “View” menu, choose “Header and Footer”; in the “Header and Footer” toolbar, click on the “Page Setup” button and deselect the check box “Different first page” in the “Layout” tab and click “OK”. Close the “Header and Footer” toolbar. Choose “Page Numbers...” from the “Insert” menu. Click on “Format...” and select the page numbering option “Continue from previous section”. Click twice on the “OK” button.

5.3.15.4 Index entry headings

5.3.15.4.1 Style

 XE "Index entry headings" Name: Index Heading XE "Index Heading" 

 XE "Styles:Index Heading" 
Automatic numbering: yes

5.3.15.4.2 Applying the style

Automatically applied to index entry headings (but see 1.1.12.4.3).

5.3.15.4.3 Remarks

The index entry headings are not inserted automatically when an index is inserted having the “template” format. For further information, see A.1.8.

5.3.16 Other elements

5.3.16.1 Style

xe “Special“Name: Special XE "Styles:Special" 
Automatic numbering: no

5.3.16.2 Applying the style

Select it from the Style drop-down list.

5.3.16.3 Remarks

Use the “Special” style for any element of text for which you are unsure as to the correct style to use, or for which you feel that none of the styles contained in the stylesheet is appropriate. Note that if you create your own style(s), they will be mapped to “Special” on exportation/importation.

Hitting return after you have entered a component styled as ‘‘Special” will put the cursor in a new paragraph in the style ‘‘Normal”.

EXAMPLE 1


Throwaway insert ISO xyz-TPGN160308-EN-P20
EXAMPLE 2

<<<<< Data packet exchange >>>>>

<-----------(CONNECT(
(CONNAck(---------->

<-----------(CONTOdd(
(Ack(---------->

<<<<< End of map session >>>>>

5.4 Other styles

5.4.1 Header

5.4.1.1  SEQ H4L2SCL2 \h \r1 Style

xe “Header“Name: Header XE "Styles:Header" 
Automatic numbering: no

5.4.1.2 Applying the style

Element inserted by the template.

5.4.1.3 Remarks

The headers are generated from the data entered in the STD manager. Therefore, changes to the headers shall be made only by changing the data in the STD manager; click on the “Doc Info” button (see 4.2) and add or change the data in the relevant dialogue box.

If the page layout necessitates the creation of a new section (see 5.1), from the “View” menu, choose “Header and Footer”; in the “Header and Footer” toolbar, click on the “Page Setup” button and deselect the check box “Different first page” in the “Layout” tab and click “OK”. Close the “Header and Footer” toolbar. Choose “Page Numbers...” from the “Insert” menu. Click on “Format...” and select the page numbering option “Continue from previous section”. Click twice on the “OK” button. (See also 1.2.2.)

5.4.2 Footer

5.4.2.1  SEQ H4L2SCL2 \h \r1 Style

 XE "Footer" Name: Footer XE "Styles:Footer" 
Automatic numbering: no

5.4.2.2 Applying the style

Element inserted by the template.

5.4.2.3 Remarks

The footer is generated from the data entered in the STD manager. Therefore, changes to the footer shall be made only by changing the data in the STD manager; click on the “Doc Info” button (see 4.2) and add or change the data in the relevant dialogue box.

If the page layout necessitates the creation of a new section (see 5.1), from the “View” menu, choose “Header and Footer”; in the “Header and Footer” toolbar, click on the “Page Setup” button and deselect the check box “Different first page” in the “Layout” tab and click “OK”. Close the “Header and Footer” toolbar. Choose “Page Numbers...” from the “Insert” menu. Click on “Format...” and select the page numbering option “Continue from previous section”. Click twice on the “OK” button. (See also 1.2.1.)

5.4.3 Help

5.4.3.1  SEQ H4L2SCL2 \h \r1 Style

xe “Help“Name: zzHelp XE "zzHelp" 

 XE "Styles:zzHelp" 
Automatic numbering: no

5.4.3.2 Applying the style

Element inserted by the template.

5.4.3.3 Remarks

The help text in “zzHelp” style only appears if the “Include notes on drafting” check box is selected in the second dialogue box of the STD managerxe “STD manager“ (see item 5 in Figure 5). It is necessary to delete these notes before finalizing your document.

NOTE
Whichever options are entered in the STD manager when the document is created (i.e. whichever document type is selected, whether the document is a part or not, whichever organization is selected, etc.), the notes concerning editorial drafting rules and the document skeleton inserted apply to an ISO International Standard.

Annex A 
(normative) SEQ aaa \h 

 SEQ table \r0\h 

 SEQ figure \r0\h 

Known problems and their solutions

A.1 Problems related to use of the template

No.
Problem
Solution

A.1.1
The presentation of the List number and List Continue styles is not always correct. XE "Problems related to:presentation of List Continue style" 

 XE "Problems related to:presentation of List number style" 
This is caused by parasitic tabulations which appear when certain levels of list style are applied: to resolve the problem, select the paragraph in which the problem occurs and in the “Format” menu select the “Tabs...” command. Click on the “Clear all” command, then set a tabulation at 20 pt for level 1, 40 pt for level 2, 60 pt for level 3 and 80 pt for level 4.

A.1.2
The numbering of the items in ordered lists is continuous from the beginning to the end of the document. XE "Problems related to:numbering of items in ordered lists" 
By default, the numbering of level 1 is continuous from the beginning to the end of the document. To restart the numbering, select the first paragraph of the list where the numbering should restart, click on the “Lists” button, select the check box “Restart numbering” and then click on the button corresponding to the appropriate level in the “Lists” dialogue box.

A.1.3
Figures and tables do not appear in the list of elements that can be cross-referenced automatically. XE "Problems related to:automatic cross-referencing of figures" 

 XE "Problems related to:automatic cross-referencing of tables" 
Cross-reference them manually.

A.1.4
An error message occurs in the titles of figures and tables in annexes.  XE "Problems related to: figure titles in annexes" 

 XE "Problems related to: table titles in annexes" 
This problem occurs in linguistic versions of Word other than English and French; position the cursor above the error message, click on the right button of the mouse and select the check box “Display field codes”; replace the switch “ALPHABETIC” by its equivalent in your linguistic version (e.g. “ALPHABÉTIQUE” in French); position the cursor again above the field, click on the right button of the mouse and select “Update fields”.

A.1.5
When a new table or a figure is inserted before an existing table or figure, the numbering of the existing table or figure is not updated automatically. XE "Problems related to:numbering of figures" 

 XE "Problems related to:numbering of tables" 
Select the number to be updated and click on F9. If this does not work, reapply the appropriate style.

A.1.6
The generated text of notes, examples, figures and tables inserted using the “Insert”  toolbar  does not appear in the document language. XE "Problems related to:wrong language of generated text" 

 XE "Problems related to:generated text, wrong language of" 
This text appears in French if the paragraph language is French, in German if it is German and in English for all other languages. Select the element concerned and modify the paragraph language by setting the language in the “Language” “Set Language...” command in the “Tools” menu.

A.1.7
One of the elements of the document title has been truncated and the following elements are missing or have been replaced by the beginning of the truncated element. XE "Problems related to:incomplete document title" 

 XE "Problems related to:document title" 
Do not use quotation marks in document titles: replace them with two apostrophes (see also 4.2.2).

A.1.8
The index entry headings are not inserted automatically when the index is inserted having the “template” format. XE "Problems related to:index entry headings" 
This will be corrected in a future version. Select a predefined index format which includes index entry headings.

A.1.9
On the cover sheet, the series number (first line) and the reference of TC/SC/WG (fourth line) of ISO documents show “ISO TC” instead of “ISO/TC”.  XE "Problems related to:cover sheet" 
Do not alter this. It will be corrected in a future version.

A.1.10
The reference number of the technical corrigendum is not correct.  XE "Problems related to: reference number of technical corrigendum " 
Do not alter this. It will be corrected in a future version.

A.1.11
The titles of the amendment or technical corrigendum are not shown after the document title on page 1 and on the cover sheet.  XE "Problems related to:cover sheet" 

 XE "Problems related to:amendment title" 

 XE "Problems related to:technical corrigendum, title" 
It is possible to add “AMENDMENT” or “TECHNICAL CORRIGENDUM”, as well as the title of the amendment or technical corrigendum: position the cursor just before the paragraph mark at the end of the document title on the cover sheet, hit return and type in the text required. Proceed in the same manner on page 1.

A.1.12
The “Scope” title appears on page 1 of an amendment or technical corrigendum.  XE "Problems related to:amendment, page 1" 

 XE "Problems related to:technical corrigendum, page 1" 
Delete it.

A.1.13
The text in the foreword has been modified.  XE "Problems related to:modification of foreword text" 

 XE "Problems related to:foreword, modification of text" 
The text of the foreword is automatically regenerated every time the STD manager is run. See 1.1.1.3.3.

A.1.14
The text “Part n”, “Part n+1” appears once or several times in the list of part titles of the foreword.  XE "Problems related to:foreword, list of part titles" 
This text is inserted automatically every time the STD manager is run. Delete what is not applicable.

A.1.15
In the table of contents, the annex heading and status are in lightface.  XE "Problems related to:table of contents" 
Do not alter this. It results from the automatic formatting of the table of contents entry in which the format of the first character of the field code is applied to the entire field (in this case, the first character in the annex status which is in lightface).

A.1.16
The style area is not displayed as it is in the ISOSTD30 template.  XE "Problems related to:style area not displayed" 
Choose the “Normal” command in the “View” menu; choose the “Options” command in the “Tools” menu and then the “View” tab. Adjust the value of the “Style area width” field as required and click on the “OK” button.

A.1.17
An error message appears at the place where the page number should be in the footer.  XE "Problems related to:error message in footer" 

 XE "Problems related to:page number error message" 
Word cannot correctly interpret certain switches in the field codes: choose the “Header and Footer” command in the “View” menu, display the footer, position the cursor above the error message, click on the right button of the mouse and select “Display field codes”; replace the switches “ROMAN”, “LOWER” and “ARABIC” by their equivalent in your linguistic version (e.g. in French they are “ROMAIN”, “MINUSCULE” and “ARABE”); position the cursor above the field, click on the right button of the mouse and select “Update field”.

A.1.18
Upon opening a file based on the template, certain styles do not have the correct presentation (numbering wrong, wrong indents, etc.).  XE "Problems related to:styles do not have the correct presentation" 
In the “Format” menu, choose the “Style...” command and click on the “Organizer...” button. In the “Organizer” dialogue box, select the “Styles” tab. Click on the “Close File” button (bottom right), then on the “Open File” button. Open the file STD.DOT. Select the set of styles in the list on the right-side and click on the “Copy” button (from STD.DOT towards your document). In answer to the question in the Microsoft Word dialogue box “Do you wish to overwrite the existing style entry a2?”, click on the button “Yes to All”. Click on the “Close” button.

A.1.19
Empty files based on the template are created by Word.  XE "Problems related to: empty files based on the template are created by Word" 
In certain configurations and when certain operations are carried out using the template or when the “Translation” and “Importation” functions are used, the STD template creates a new empty document. Delete these files.

A.1.20
The list of available styles is more extensive than that indicated in this manual.  XE "Problems related to:list of styles more extensive than it should be" 
Each time that the STD manager is run the complete set of Word predefined styles is added to the template. Do not use these additional styles; delete them.

A.2 Problems related to saving and managing files

No.
Problem
Solution

A.2.1
When saving a document, the “Cancel” button does not work.  XE "Problems related to:saving a document" 
This is a feature built into the template.

A.2.2
When changing administrative data having an influence on the file name (see 4.5.1), it is not possible to delete the link with the linked file in the other language, and thus make a “translation”.  XE "Problems related to:linked file, deletion of " 
Make the same changes in the administrative data of the linked file.

A.2.3
When the file is saved under another name than that defined by the STD template, every time the STD manager is run it regenerates the original file name from the administrative data.  XE "Problems related to:saving renamed files" 
This is a feature built into the template.

A.2.4
When opening the file, the “Standardization system” dialogue box is grey.  XE "Problems related to:Standardization system dialogue box" 
This will be corrected in a future version. See 4.3.3.

A.2.5
When running the STD manager or using the “Translation” button, an ISO/IEC document is transformed into an ISO document. XE "Problems related to:ISO/IEC document is transformed into an ISO document" 
Check that the organization selected in the STD manager dialogue box is “ISO/IEC” before clicking on the “End” button. This will be corrected in a future version. 

A.2.6
When opening the file, a message indicates that by enabling the macros you may infect your computer with a virus.  XE "Problems related to:message concerning macro viruses" 
The template can only work using macros. When the check box “Macro virus protection” is selected in the “Options” command of the “Tools” menu (“General” tab), the software displays a message indicating that the file may be infected by a virus. If the file has come from a reliable source, click on the button “Enable macros”, otherwise use an antivirus program to be sure the file is not infected.

A.2.7
When opening the file, a Microsoft Visual Basic window opens.  XE "Problems related to:Microsoft Visual Basic window" 
The file is certainly based on the MDN template (see the text at the bottom of the cover sheet). Close the Visual Basic window, then open a new document based on the STD template, enter the relevant data into the STD manager and cut all the text following the “Scope” clause in the original document. Next paste this text into a suitable location in the newly created document. Proceed in the same manner for the foreword and introduction, as necessary.

A.2.8
The document to be synchronized is created but the administrative information is not updated.  XE "Problems related to:synchronization" 
This problem only occurs in certain configurations. Do not use the “Synchronization” function (see related problem in A.2.9).

A.2.9
When running the STD manager, another document based on the template opens.  XE "Problems related to:document based on the template opens" 
The document that opens was previously synchronized with the current document for which you are running the STD manager. Do not use the “Synchronization” function (see related problem in A.2.8).

A.3 Problems related to the importation of documents created using the ISOSTD30 and ISOSTD33 templates

No.
Problem
Solution

A.3.1
The document type “Technical Report” is not recognized when imported. XE "Problems related to:document type \“Technical Report\” is not recognized when imported" 
Select it manually from the drop-down list in the STD manager when importing the file.

A.3.2
Importing a document creates a second table of contents.  XE "Problems related to:two tables of contents in a document" 
Delete one of the two tables of contents.

A.3.3
The entry levels of the table of contents are not the same as those of the original document.  XE "Problems related to:entry levels of table of contents incorrect" 

 XE "Problems related to:table of contents, incorrect levels in" 
Alter the levels as required. See 1.1.1.3.3.

A.3.4
The styles for a list are not correctly applied.  XE "Problems related to:list styles incorrect" 
In the ISOSTD30 and ISOSTD33 templates, only the “List Continue” style is the same as that in the STD template. Manually apply the required style.

A.3.5
The numbering of the titles is incorrect.  XE "Problems related to:titles, numbering is incorrect" 
Check that the correct styles have been applied then close the document and re-open it.

A.3.6
The document type and reference number of the document are not recovered when importing documents prepared using ISOSTD33.  XE "Problems related to:document type not recovered" 

 XE "Problems related to:reference number of document not recovered" 
Enter them manually in the STD manager when importing the file.

A.3.7
The SEQ fields of table and figure footnotes of documents prepared using ISOSTD33 are not correctly translated.  XE "Problems related to:SEQ fields not correctly translated" 
This will be corrected in a future version.

A.3.8
The foreword text is not always updated automatically.  XE "Problems related to:foreword, text not updated automatically" 
Select the foreword text up to the parts list and apply the “Foreword” style to this selection. See also 1.1.1.3.

A.3.9
The imported document contains only a cover sheet.  XE "Problems related to:imported document, contains only a cover sheet" 
The original document consisted of only a single section. Insert a section break at the bottom of the cover sheet and another one after the introduction, and import the document again.

A.3.10
The imported document contains only a cover sheet and the preliminary informative section.  XE "Problems related to:imported document, contains only a cover sheet and the preliminary informative section" 
The original document consisted of only two sections. Insert the missing section break either at the bottom of the cover sheet or after the introduction and import the document again.

A.3.11
The landscape format sections in the original document have been imported in a portrait format.  XE "Problems related to:imported document, landscape section imported in portrait format" 
Reformat these sections.

A.3.12
An error message appears in the titles of figures and tables in annexes.  XE "Problems related to:error message in figure and table titles" 
Delete the text “FigureError! Unknown switch argument. —” and reapply the style using the appropriate button on the “Insert” toolbar.

A.3.13
The document is not imported but simply opened.  XE "Problems related to:importation, document not imported but simply opened" 
Create a new document based on the STD template and enter the relevant administrative data in the STD manager. Next, in the source document, cut all the text following the scope and paste it into a suitable place in the newly created template document. Follow the same procedure for the foreword and introduction as necessary. 

A.3.14
Upon opening a file based on the template, certain styles do not have the correct presentation (numbering wrong, wrong indents, etc.).  XE "Problems related to:styles do not have the correct presentation" 
In the “Format” menu, choose the “Style...” command and click on the “Organizer...” button. In the “Organizer” dialogue box, select the “Styles” tab. Click on the “Close File” button (bottom right), then on the “Open File” button. Open the file STD.DOT. Select the set of styles in the list on the right-side and click on the “Copy” button (from STD.DOT towards your document). In answer to the question in the Microsoft Word dialogue box “Do you wish to overwrite the existing style entry a2?”, click on the button “Yes to All”. Click on the “Close” button.

Annex B 
(informative)
SEQ aaa \h 

SEQ table \r0\h 

SEQ figure \r0\h 
Summary of template styles XE "Summary of template styles" 
Style name a
Use
Apply using b
See



“Insert” button
“Framework” button
Style drop-down list


a2
Titles of annex clauses  (for example A.1) — Automatically numbered
X


5.2.1

a3
Titles of annex subclauses, level 1 (for example A.1.1) — Automatically numbered
X


5.2.2.2

a4
Titles of annex subclauses, level 2 (for example A.1.1.1) — Automatically numbered
X


5.2.2.2

a5
Titles of annex subclauses, level 3 (for example A.1.1.1.1) — Automatically numbered
X


5.2.2.2

a6
Titles of annex subclauses, level 4 (for example A.1.1.1.1.1) — Automatically numbered
X


5.2.2.2

ANNEX
Heading, status and annex title — Automatically numbered

X

5.2.5

ANNEXN
Not used in ISO template
—
—
—
—

ANNEXZ
Not used in ISO template
—
—
—
—

bibliography
Reference entries in the bibliography


X
1.1.11.3

Body Text*
Used for table texts


X
1.1.8.3

Body Text 2
Used for table texts in large tables


X
1.1.8.3

Body Text 3
Used for table texts in very large tables


X
1.1.8.3

Default Paragraph Font*
Character style predefined in Word
—
—
—
—

Definition
Text of definitions
X
X

1.1.3.4.4

Defterms
Character style used to identify cross-references to terms defined in the “Terms and definitions” clause


X
1.1.9.1

Example
Examples
X


1.1.5

ExtXref
Character style used to identify cross-references to normative references defined in the “Normative references” clause


X
1.1.9.2

Figure footnote
Figure footnote


X
1.1.7.4

Figure title
Figure title — Automatically numbered
X


1.1.7.5

Footer*
Built-in style in Word for footers inserted using the “Footer and Header” command


X
1.2.2

Footnote Reference*
Built-in character style in Word for references to footnotes inserted using the “FootNote” button
X


1.1.6

Footnote Text*
Built-in style in Word for footnote text inserted using the “Foot Note” button — Automatically numbered
X


1.1.6

Foreword
Foreword text automatically generated by the template


X
1.1.1.3

Formula
Displayed mathematical and chemical formulae
X


1.1.10

Header*
Built-in style in Word for a header inserted using the “Header and Footer” command


X
1.2.1

Heading 1*
Clause titles — Built-in style in Word
X


5.2.1

Heading 2*
Subclause titles, level 1 — Built-in style in Word — Automatically numbered
X


5.2.2.2

Heading 3*
Subclause titles, level 2 — Built-in style in Word — Automatically numbered
X


5.2.2.2

Heading 4*
Subclause titles, level 3 — Built-in style in Word — Automatically numbered
X


5.2.2.2

Heading 5*
Subclause titles, level 4 — Built-in style in Word — Automatically numbered
X


5.2.2.2

Heading 6*
Subclause titles, level 5 — Built-in style in Word — Automatically numbered
X


5.2.2.2

Heading 7*
Built-in style in Word — Not used in the ISO template
—
—
—
—

Heading 8*
Built-in style in Word — Not used in the ISO template
—
—
—
—

Heading 9*
Built-in style in Word — Not used in the ISO template
—
—
—
—

Index 1*
Built-in style in Word for index entries


X
1.1.12.3

Index 2*
Built-in style in Word for index subentries — Not used in the ISO template
—
—
—
—

Index 3*
Built-in style in Word for index subentries — Not used in the ISO template
—
—
—
—

Index 4*
Built-in style in Word for index subentries — Not used in the ISO template
—
—
—
—

Index 5*
Built-in style in Word for index subentries — Not used in the ISO template
—
—
—
—

Index 6*
Built-in style in Word for index subentries — Not used in the ISO template
—
—
—
—

Index 7*
Built-in style in Word for index subentries — Not used in the ISO template
—
—
—
—

Index 8*
Built-in style in Word for index subentries — Not used in the ISO template
—
—
—
—

Index 9*
Built-in style in Word for index subentries — Not used in the ISO template
—
—
—
—

Index Heading*
Built-in style in Word for index entry headings

X

1.1.12.4

Introduction
“Introduction” title

X

1.1.2.2

List Continue*
Unordered list items, level 1 — Automatically numbered
X


5.2.4.2

List Continue 2*
Unordered list items, level 2 — Automatically numbered
X


5.2.4.2

List Continue 3*
Unordered list items, level 3 — Automatically numbered
X


5.2.4.2

List Continue 4*
Unordered list items, level 4 — Automatically numbered
X


5.2.4.2

List Number*
Ordered list items, level 1 — Automatically numbered
X


5.2.4.3

List Number 2*
Ordered list items, level 2 — Automatically numbered
X


5.2.4.3

List Number 3*
Ordered list items, level 3 — Automatically numbered
X


5.2.4.3

List Number 4*
Ordered list items, level 4 — Automatically numbered
X


5.2.4.3

MSDNFR
“Tool” style — Not used in the ISO template
—
—
—
—

na2
Not used in the ISO template
—
—
—
—

na3
Not used in the ISO template
—
—
—
—

na4
Not used in the ISO template
—
—
—
—

na5
Not used in the ISO template
—
—
—
—

na6
Not used in the ISO template
—
—
—
—

Normal*
Style by default predefined in Word for text


X
5.2.3

Note
Notes integrated in text, figures and tables
X


1.1.4, 1.1.7.3, 1.1.8.4

Page number*
Built-in character style in Word for page numbers automatically inserted using the “Page Numbers” command
—
—
—
—

p2
Subclauses without titles, level 1
X


5.2.2.3

p3
Subclauses without titles, level  2
X


5.2.2.3

p4
Subclauses without titles, level  3
X


5.2.2.3

p5
Subclauses without titles, level  4
X


5.2.2.3

p6
Subclauses without titles, level  5
X


5.2.2.3

RefNorm
Normative references in the “Normative references” clause


X
1.1.3.3

Special
Style for text elements for which the correct style is not known with certainty or for which no other template style is suitable


X
1.1.13

Table footnote
Table footnote text style


X
1.1.8.5

TableFootNoteXref
Character style for table footnote references and their identification letters 


X
1.1.8.5

Table title
Table title — Automatically numbered
X


1.1.8.2

Term(s)
Terms defined in the “Terms and definitions” clause or in a terminology document
X
X

1.1.3.4.3

TermNum
Reference numbers of the terms defined in the “Terms and definitions” clause or in a terminology document
X
X

1.1.3.4.2

TOC 1*
Table of contents entry, level 1 — Built-in style in Word

X

1.1.1.3

TOC 2*
Table of contents entry, level 2 — Built-in style in Word

X

1.1.1.3

TOC 3*
Table of contents entry, level 3 — Built-in style in Word

X

1.1.1.3

TOC 4*
Table of contents entry, level 4 — Built-in style in Word

X

1.1.1.3

TOC 5*
Table of contents entry, level 5 — Built-in style in Word

X

1.1.1.3

TOC 6*
Table of contents entry, level 6 — Built-in style in Word

X

1.1.1.3

TOC 7*
Built-in style in Word for table of contents entries
—
—
—
—

TOC 8*
Built-in style in Word for table of contents entries
—
—
—
—

TOC 9*
Table of contents entry for unnumbered elements

X

1.1.1.3

zzBiblio
“Bibliography” title

X

1.1.11.2

zzContents
“Contents” title

X

1.1.1.2

zzCopyright
Copyright notice
—
—
—
—

zzCover
Cover sheet of document
—
—
—
5.3.1

zzForeword
“Foreword” title


X
1.1.1.2

zzHelp
Editorial notes on drafting
—
—
—
1.2.3

zzIndex
“Index” title

X

1.1.12.2

zzLc5
“Tool” style for numbering lists — Do not use
—
—
—
—

zzLc6
“Tool” style for numbering lists — Do not use
—
—
—
—

zzLn5
“Tool” style for numbering lists — Do not use
—
—
—
—

zzLn6
“Tool” style for numbering lists — Do not use
—
—
—
—

zzSTDTitle
Document title, on the first page of section 3
—
—
—
5.3.2

a
Style names marked with an asterisk are based on predefined Microsoft styles. These styles are recognized by the various linguistic versions of Word and their names will be translated automatically into the language of the Word version which you are using. For these Microsoft styles, the user will need to derive the correspondence between the name displayed and that given in this table; for example, if the same document is opened using English and French versions of Word, text styled “Footnote Reference” in the English version is called “Appel de note” in the French version.

b
The “Insert” and “Framework” buttons have certain automated functionalities associated with them (e.g. automatic inserts are programmed for certain styles). Although the complete set of available template styles is also accessible via the Style drop-down list in the formatting toolbar and the “Style” command of the “Format” menu, unless otherwise specified do not use these for applying styles since the automated features will be missing; use the “Insert” and “Framework” buttons.

Annex C 
(informative)
SEQ aaa \h 

SEQ table \r0\h 

SEQ figure \r0\h 
Which styles correspond to which element — Quick reference guide

Element
Style name a XE “Style”
Apply using b
Automatic numbering
See



“Insert” button
“Framework” button
Style drop-down list



Any element of text for which the correct style to use is not known with certainty or for which no other style of the template is suitable
Special


X

1.1.13

Annex
heading, status and title
ANNEX

X

X
5.2.5

Bibliography
reference entry
bibliography


X
X
1.1.11.3


title
zzBiblio

X


1.1.11.2

Clause
annexes
a2
X


X
5.2.1


body of document
Heading 1*
X


X
5.2.1

Definition
Definition
X
X


1.1.3.4.4

Displayed mathematical and chemical formulae
Formula
X



1.1.10

Example
Example
X



1.1.5

Figure
footnote
Figure footnote


X

1.1.7.4


note
Note
X



1.1.7.3


title
Figure title
X



1.1.7.5

Figure footnote
Figure footnote


X

1.1.7.4

Footnote
reference
Footnote Reference*
X


X
1.1.6


text
Footnote Text*
X



1.1.6

Footnote text
Footnote Text*
X


X
1.1.6

Foreword
text
Foreword


X

1.1.1.3


title
zzForeword


X

1.1.1.2

Index
entry
Index 1*


X

1.1.12.3


entry heading
Index Heading*


X

1.1.12.4


“Index” title
zzIndex

X


1.1.12.2

Introduction
text
Normal*


X

5.2.3


title
Introduction

X


1.1.2.2

List
ordered
level 1
List Number*
X


X
5.2.4.3



level 2
List Number 2*
X


X
5.2.4.3



level 3
List Number 3*
X


X
5.2.4.3



level 4
List Number 4*
X


X
5.2.4.3

List
unordered
level 1
List Continue*
X


X
5.2.4.2



level 2
List Continue 2*
X


X
5.2.4.2



level 3
List Continue 3*
X


X
5.2.4.2



level 4
List Continue 4*
X


X
5.2.4.2

Normative reference
cross-reference to a normative reference defined in the “Normative references” clause
ExtXref


X

1.1.9.2


in “Normative references” clause
RefNorm


X

1.1.3.1

Note integrated in text, figures and tables
Note
X



1.1.4, 1.1.7.3, 1.1.8.4

Paragraph
Normal*


X

5.2.3

Subclause without title
level 1
p2
X



5.2.2.3


level 2
p3
X



5.2.2.3


level 3
p4
X



5.2.2.3


level 4
p5
X



5.2.2.3


level 5
p6
X



5.2.2.3

Subclause with title
annexes
level 1
a3
X


X
5.2.2.2



level 2
a4
X


X
5.2.2.2



level 3
a5
X


X
5.2.2.2



level 4
a6
X


X
5.2.2.2


body of text
level 1
Heading 2*
X


X
5.2.2.2



level 2
Heading 3*
X


X
5.2.2.2



level 3
Heading 4*
X


X
5.2.2.2



level 4
Heading 5*
X


X
5.2.2.2



level 5
Heading 6*
X


X
5.2.2.2

Table
note
Note
X



1.1.8.4


table footnote
See Table footnote.


text
Body text*


X

1.1.8.3


text of a big table
Body Text 2


X

1.1.8.3


text of a very big table
Body Text 3


X

1.1.8.3


title
Table title
X



1.1.8.2

Table footnote
identification letter of the table footnote
TableFootNoteXref


X

1.1.8.5


reference
TableFootNoteXref


X

1.1.8.5


text
Table footnote


X

1.1.8.5

Table of contents
“Contents” title
zzContents

X


1.1.1.2


entries
level 1
TOC 1*

X


1.1.1.3



level 2
TOC 2*

X


1.1.1.3



level 3
TOC 3*

X


1.1.1.3



level 4
TOC 4*

X


1.1.1.3



level 5
TOC 5*

X


1.1.1.3



level 6
TOC 6*

X


1.1.1.3



unnumbered elements
TOC 9*

X


1.1.1.3

Term
cross-reference to a term defined in the “Terms and definitions” clause
Defterms


X

1.1.9.1


in the “Terms and definitions” clause in a terminology document
Term(s)
X
X


1.1.3.4.3


reference number
TermNum
X
X


1.1.3.4.2

a
Style names marked with an asterisk are based on predefined Microsoft styles. These styles are recognized by the various linguistic versions of Word and their names will be translated automatically into the language of the Word version which you are using. For these Microsoft styles, the user will need to derive the correspondence between the name displayed and that given in this table; for example, if the same document is opened using English and French versions of Word, text styled “Footnote Reference” in the English version is called “Appel de note” in the French version.

b
The “Insert” and “Framework” buttons have certain automated functionalities associated with them (e.g. automatic inserts are programmed for certain styles). Although the complete set of available template styles is also accessible via the Style drop-down list in the formatting toolbar and the “Style” command of the “Format” menu, unless otherwise specified do not use these for applying styles since the automated features will be missing; use the “Insert” and “Framework” buttons.
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A
a2

15

a3

16

a4

16

a5

16

a6

16

Administrative information

entering
6

Amendment title
7

ANNEX
20

Annexes
20

Apparatus
17

B
Basic clauses
26

Bibliographic references
43

bibliography
43

Bibliography
43

Binoculars button
13

Blue text
4

Body text
39

Body text 2
39

Body text 3
39

C
Classification and designation clause
31

Clause

Classification and designation
31

Conformance
26

Marking, labelling and packaging
31

Normative references
26

Requirements
30

Sampling
30

Scope
26

Symbols and abbreviated terms
29

Terms and definitions
27

Test methods
30

Clause/Subclause with title button
15, 16

Clauses
15

Conformance clause
26

Contents title
23

insertion of
23

Cover sheet
21

Creating a new document based on the STD template
2

Creating a new section
14

Creating documents
5

from pre-existing files created using the STD template
12

Cross-references
41

to a normative document
41

to numbered elements
41

to terms defined in the document
41

D
Definition
29

Defterms
41

Displayed mathematical and chemical formulae
42

numbering
42

Doc Info button
3

Document language cannot be modified
5

Document title
21

Document titles
7

synchronizing
13

Drawings
34

E
Editorial drafting rules

notes concerning
9

Emphasizing text
17, 18

End button
8

Example
32

Examples integrated in the text
32

numbering of
32

Export button
4

ExtXref
41

F
Figure

inserting a graphics file
34

Figure footnote
35

references
36

Figure footnotes
35

Figure title
36

Figure titles
36

Figures
33

File name appearing in red
13

Footer
46

Footnote references
33

Footnotes to the text
33

Foreword
24

text
24

title
24

Foreword title
24

Formula
42

Framework
10

Framework button

3, 14, 20, 26, 27, 29, 30, 31, 43

automation associated with
14

Framework dialogue box
11

Framework elements

deletion of
10

G
Green text
5

H
Hardware configuration
1

Header
46

Heading 1
15

Heading 2
16

Heading 3
16

Heading 4
16

Heading 5
16

Heading 6
16

Help
47

I
Import button
3

Importing files
9

created using a different template
9

created using ISOSTD30
9

created using ISOSTD33
9

created using the STD template, where the standardization system is not available
9

Index
44

Index 1
44

Index entries
44

Index entry headings
45

Index Heading
45

Indexes

generation of
44

Insert button
3, 14, 15

automation associated with
14

Insert toolbar
16

Insertion of framework elements
10

Installation of the template
1

Introduction
25

Introduction title
25

ITSIG Guide
42

L
Language

of document cannot be modified
5

of element titles
10

of the dialogue boxes
4

of the document
6

Linking graphics files
34

Links between

files
12

language versions
12

List Continue
18

List Continue 2
18

List Continue 3
18

List Continue 4
18

List item identifiers

ordered list
19

unordered list
19

List Number
19

List Number 2
19

List Number 3
19

List Number 4
19

List of variables, styles to use for
43

Lists
18

M
Managing versions
12

Marking, labelling and packaging clause
31

Microsoft Equation Editor 3.0 parameters
42

Modified foreword text
25

N
Nested elements
14

Normal
18, 34

Normal keyboard shortcut
18

Normative reference
27

Normative references clause
26

Note
32, 35, 40

Notes

to figures
35

to tables
40

Notes concerning editorial drafting rules
9

Notes integrated in the text
31

Numbering a displayed formula
42

O
Options button
4

Ordered lists
19

P
p2

17

p3

17

p4

17

p5

17

p6

§17

Paragraphs
18

Parameters dialogue box
13

Problems related to

amendment title
49

amendment, page 1
49

automatic cross-referencing of figures
48

automatic cross-referencing of tables
48

cover sheet
49

document based on the template opens
51

document title
48

document type “Technical Report” is not recognized when imported
51

document type not recovered
51

empty files based on the template are created by Word
50

entry levels of table of contents incorrect
51

error message in figure and table titles
52

error message in footer
49

figure titles in annexes
48

foreword, list of part titles
49

foreword, modification of text
49

foreword, text not updated automatically
51

generated text, wrong language of
48

importation, document not imported but simply opened
52

imported document, contains only a cover sheet
51

imported document, contains only a cover sheet and the preliminary informative section
52

imported document, landscape section imported in portrait format
52

incomplete document title
48

index entry headings
49

ISO/IEC document is transformed into an ISO document
50

linked file, deletion of
50

list of styles more extensive than it should be
50

list styles incorrect
51

message concerning macro viruses
50

Microsoft Visual Basic window
51

modification of foreword text
49

numbering of figures
48

numbering of items in ordered lists
48

numbering of tables
48

page number error message
49

presentation of List Continue style
48

presentation of List number style
48

reference number of document not recovered
51

reference number of technical corrigendum
49

saving a document
50

saving renamed files
50

SEQ fields not correctly translated
51

Standardization system dialogue box
50

style area not displayed
49

styles do not have the correct presentation
50, 52

synchronization
51

table of contents
49

table of contents, incorrect levels in
51

table titles in annexes
48

technical corrigendum, page 1
49

technical corrigendum, title
49

titles, numbering is incorrect
51

two tables of contents in a document
51

wrong language of generated text
48

R
Reagents
17

Red file name
13

Red text
5

Renaming a file
11

problems associated with
11

Replaced documents
8

Replaced documents dialogue box
8

Requirements clause
30

S
Sampling clause
30

Saving files
11

in a different format
12

in Word 6.0/95 format
12

Scope clause
26

Sections

creating new
14

Sending files to the ISO Central Secretariat
35

Special
45

Standardization system
5

Standardization system dialogue box
6

STD manager
4, 47

STD toolbar
3

Style
57

Styles

a2
15

a3
16

a4
16

a5
16

a6
16

ANNEX
20

bibliography
43

Body text
39

Body text 2
39

Body text 3
39

Definition
29

Defterms
41

Example
32

ExtXref
41

Figure footnote
35

Figure title
36

Footer
46

Footnote
33

Foreword
24

Formula
42

Header
46

Heading 1
15

Heading 2
16

Heading 3
16

Heading 4
16

Heading 5
16

Heading 6
16

Index 1
44

Index Heading
45

Introduction
25

List Continue
18

List Continue 2
18

List Continue 3
18

List Continue 4
18

List Number
19

List Number 2
19

List Number 3
19

List Number 4
19

Normal
18, 34

Note
32, 35, 40

p2
17

p3
17

p4
17

p5
17

p6
17

Special
45

Table footnote
40

Table title
37

Term(s)
28

TermNum
28

TOC 1
23

TOC 2
23

TOC 3
23

TOC 4
23

TOC 5
23

TOC 6
23

TOC 9
23

zzBiblio
43

zzContents
23

zzCover
21, 22

zzForeword
24

zzHelp
47

zzIndex
44

zzSTDTitle
22

Subclauses
16

with titles
16

without titles
17

Summary of template styles
53

Symbols and abbreviated terms clause
29

Synchronize button
13

Synonyms

how to enter
29

T
Table content
38

Table footnote
40

Table footnotes
40

Table of contents
22, 23

insertion of
24

updating
23

Table of figures
24

insertion of
24

Table of tables
24

insertion of
24

Table title
37

Table titles
37

Tables
37

Tables continued over two or more pages

repetition of title
38

Technical Corrigendum title
7

Term
28

Term reference number
28

Term(s)
28

TermNum
28

Terms and definitions clause
27

Terms of use for the STD template
1

Test methods clause
30

Title “Bibliography”
43

Title “Index”
44

Titles
7

Titles dialogue box
7

TOC 1
23

TOC 2
23

TOC 3
23

TOC 4
23

TOC 5
23

TOC 6
23

TOC 9
23

Translate button
3

Translating

a document
12

basic elements
12

U
Unordered lists
18

Z
zzBiblio
43

zzContents
23

zzCover
21, 22

zzForeword
24

zzHelp
47

zzIndex
44

zzSTDTitle
22
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